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Lesson 1

Touring Excel

> What You Will Learn

Starting Excel

Naming and Saving a Workbook
Exploring the Excel Window
Exploring the Excel Interface
Navigating the Worksheet

Changing Worksheet Views

Closing a Workbook and Exiting Excel

Software Skills When you want to analyze business, personal, or financial
data and create reports in a table format consisting of rows and columns, use the
Microsoft Excel 2013 spreadsheet application in the Microsoft Office 2013 suite.

What You Can Do

Starting Excel

Start Excel from the Windows 8 Start screen.
e Click the Excel 2013 tile to start the program.

e You can also find the program on the Apps screen. Scroll to the Excel 2013
tile and click to start.

When you create a new blank worksheet, Excel displays a list of recently used
files and a gallery of available templates.

Click the Blank workbook tile to create a new Excel document.

When Excel starts, it displays an empty workbook with one worksheet.
A worksheet contains rows and columns that intersect to form cells.
Gridlines mark the boundaries of each cell.

WORDS TO KNOW

Active cell

The active cell contains
the cell pointer. There is
a dark outline around the
active cell.

The Backstage view
A feature of Microsoft
Office 2013 from which
you access file and
program management
commands.

Cell

A cell is the intersection
of a column and a row on
a worksheet. You enter
data into cells to create a
worksheet.

Cell address or cell
reference

The location of a cell in
a worksheet as identified
by its column letter and
row number.

Formula bar

As you enter data in a
cell, it simultaneously
appears in the formula
bar, which is located
above the worksheet.
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Scroll

A way to view locations
on the worksheet without
changing the active cell.

Sheet tabs

Tabs that appear at the
bottom of the workbook
window, which display the
name of each worksheet.

SkyDrive

A file hosting service
that allows you to upload
and sync files to a
virtual, or cloud, storage
environment. Files can
then be accessed from a
Web browser or a local
device.

m Starting Excel

From the Windows Start screen,

click the Excel 2013 program tile.

v If your keyboard has a Windows key
(a key with the Windows logo on it),
you can press that key at any time to
display the Start screen.

OR

a. Right-click a blank area of the
Windows Start screen.

b. Click the All apps button .

¢. Scroll to the Excel 2013 tile.

d. Click Excel 2013.

o

OR
a. Move the mouse pointer to the
lower-left corner of the screen.

b. When you see the Windows
Start screen icon, click to open
the start screen.

Click Blank workbook.

Explore the features of the Excel
program window.

Leave the file open to use in the
next Try It.

Tab scrolling buttons Quick Access Toober | | Tas | The Excel window
Buttons that appear to = T T i

the_ left of the sheet tabs, o LGk T :':T:”Ff' L e —— =
which allow you to scroll :

hidden tabs into view.

Template

A document that contains
formatting, styles, and
sample text that you

can use to create new
documents.

Workbook
An Excel file with one or
more worksheets.

Worksheet :

The work area for entering D .
and calculating data made
up of columns and rows
separated by gridlines
(light gray lines). Also
called a spreadsheet.

Vertical scroll bar

Tab scrolling buttons
- || Sheet tab

Status bar

Zoom slider |

View buttons \

Naming and Saving a Workbook

m After entering data in a workbook, you must save it, or that data will be lost when
you exit Excel.

m A saved workbook is referred to as a file.

m A file may be saved on a hard disk, a removable disk, a shared group drive, or
to the SkyDrive. Files saved to the SkyDrive are stored virtually on Microsoft’s
SkyDrive.com Web site.

m You must provide a name for the file when you save it. File names should be
descriptive, with a limit of 255 characters for the name, disk drive, and path.

m A file name may contain letters, numbers, and spaces, butnot\/:*?“<>or|.

m Excel automatically adds a period and a file type extension (usually .xlsx) to the
end of a file name when you save it.



B You must select a location in which to save your

file, for example, the Documents folder. You can
also create new folders in which to store your
workbooks.

The default Excel file format is .xIsx, or Strict Open
XML Spreadsheet file format. This XML-based file
format allows your workbooks to integrate more
easily with outside data sources and results in
smaller workbook file sizes than in earlier versions
of Excel.

v You can install updates to some older versions of Excel so
they can read the new .xIsx format.

Data can also be saved in other formats, such as
HTML, Excel Binary (a file format for very large
workbooks), or older versions of Excel (.xIs).

v You might want to save data in a different format in order to
share that data with someone who uses a different version
of Excel or a Web browser to view your data.

The Backstage view shows the places in which
you can save your file, such as the SkyDrive or
Computer. The the Backstage view will display the
first time you save a file.

m Naming and Saving a Workhook
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v You can exit the the Backstage view by clicking the Back
button .

When you select Computer, the Recent Folders list
provides the locations of folders you have recently
opened.

You can select a different storage location by
double-clicking Computer or by clicking Browse.

Once you've saved a workbook, you need only
click the Save button H as you work to resave any
changes made since the last save action. You will
not need to reenter the file name.

You can save a previously saved file with a
different name by using the Save As tab in the the
Backstage view.

Click Browse to browse to a location and the Save
As dialog box will open.

v If the location where you want to store the file displays in
the the Backstage view, click it instead of clicking Browse.

In the Save As dialog box, you can rename the file,
browse to a location, and save the file.

@ Click the FILE tab.

OR

Click the Save button H on the Quick Access
Toolbar.

Click Save As.
Click Computer and then click Browse &' .

OR
Double-click Computer.

o In the File name text box, type E01Try_xx.

Use the Navigation pane to navigate to the
location where your teacher instructs you to
store the files for this lesson.

v Use the drop-down lists at the top of the Save As dialog
box or the locations in the Navigation pane at the left to
select the folder to save to. Clicking the triangle beside
any disk or folder in the Navigation pane displays or
hides that location’s contents. If saving to a USB drive,
make sure it is inserted. Scroll down the Navigation pane
at left, and click the USB drive under Computer. Refer
to Lesson 1 of the Basics section of this book for more
information on navigating.

v Replace xx with your own name or initials, as instructed o Click the Save button.
by your teacher. For example, if your name is Mary Jones,
type EO1Try_MaryJones or EO1Try_MJ. o Leave the file open to use in the next Try It.
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Exploring the Excel Window

In the worksheet, a green border appears around
the active cell.

You can change the active cell using the mouse,
touch device, or keyboard.

Data is entered into the active cell.

The Name box, located on the left side of the
formula bar, displays the cell reference or cell
address of the active cell (its column letter and row
number). For example, A1 is the cell in the first row
of the first column. B5 is the address for the cell in
the fifth row of the second column.

m Exploring the Excel Window

QOO0 B®OO
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To help you identify the cell reference for the active
cell, Excel surrounds the cell with a dark border
and highlights its column letter (at the top of the
worksheet) and row number (to the left of the
worksheet). The column letters and row numbers
are also known as the column and row headings.

You can use the arrow keys =l (alone

or in combination with other keys), special key
combinations, the mouse, a touch device, or Go To
to select a cell on the current worksheet.

In the EO1Try_xx file, press [2] twice.

Press [ four times.

Click in the Name box, type b3, and press [ .
Press [.

Click cell F13.

Press + [rove] .

Save the E01Try_xx file, and leave it open
to use in the next Try It.

Key worksheet features

™

= v|:‘

\\

Name box B | € D

Formula bar

Active cell

L= T T, IS S TE R R
l% [

Exploring the Excel Interface

In the Microsoft Office Basics section, you learned
that you can access common commands such as
Save and Undo through the buttons on the Quick
Access Toolbar.

Through the FILE tab, you can access commands
for managing files such as New, Open, Save, and
Print. Clicking the FILE tab displays the Backstage
view.

The Ribbon, located at the top of the Excel
window, offers buttons for the most common Excel
commands.

The Ribbon offers several tabs, and on each tab,
related command buttons are arranged in groups.
Click a tab to display its contents, and then click
a button to choose a command or display further
choices.

Some tabs, called contextual tabs, appear only
when you’ve selected an item to which the tab’s
commands apply.

To access Help, click the Help button 2 .



Learning Microsoft Excel 2013 |

Chapter 1

m Exploring the Excel Interface

In the EO1Try_xx file, click the FILE tab.

Print.

of the window to go back to your document.
Click the FORMULAS tab.

© ® 00

In the list at the left of the Backstage view, click

Click the Back button in the upper-left corner

00 ©

On the FORMULAS tab, in the Function Library
group, click the Date & Time button |E.

Press [Esc].
Click the HOME tab.

Save the E01Try_xx file, and leave it open
to use in the next Try It.

Navigating the Worksheet m You can move to a specific cell that’s not onscreen
using Go To or the Name box.
- The_re are_ 16,384 columns and 1 ’048,’ 576 rows . v You can also use the Name box to go directly to a named
available in a worksheet, but you don't need to fill L .
. . o cell or range. This is discussed in Lesson 13.
the entire worksheet in order to use it—just type
data in the cells you need. m The Go To function allows you to go to a specific
Since the workbook window displays only a part of cell and make that cell active.
a worksheet, you scroll through the worksheet to ® You can open the Go To dialog box by clicking

view another location.
With the mouse or a touch device, you can scroll

HOME > Find & Select > Go To.

v In this book, the symbol > is used to indicate a series of

using the horizontal or vertical scroll bars. steps.

v Using the mouse or touch device to scroll does not change

the active cell. m  When you type the cell address into the Reference

box and select OK, that cell will become the active

m  With the keyboard, you can scroll by pressing cell.

specific keys or key combinations.

v Scrolling with the keyboard does change the active cell.

m Navigating the Worksheet

In the EO1Try_xx file, click the down
scroll arrow on the vertical scroll bar to
scroll one row down.

Drag the scroll box on the horizontal scroll bar
all the way to the left to redisplay column A.

Click HOME > Find & Select > Go To.
In the Reference text box, type ZZ88.
Click OK.

Press + to return to cell Al.

Save the EO01Try_xx file, and leave it open
to use in the next Try It.

Click the right scroll arrow on the horizontal
scroll bar to scroll one column right.

Roll the mouse wheel down until row 52 comes
into view. (Do not press the wheel, just lightly roll
it with your fingertip.)

® ® O
00000 O

v If you are using a touchpad, click the down arrow on the
vertical scroll bar.

©

Click above the scroll box on the vertical scroll
bar once or twice to redisplay row 1.
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Changing Worksheet Views

To view or hide the formula bar, ruler, column and
row headings, or gridlines, select or deselect them
by checking or clearing the applicable check box in
the Show group on the VIEW tab.

v Hiding screen elements shows more rows onscreen.

To hide and redisplay the Ribbon, double-click any
tab.

Normal view is the default working view.

Page Layout view is used to view data as it will look
when printed and make adjustments.

Page Break Preview is used before printing, to
adjust where pages break.

m Changing Worksheet Views
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v You'll learn more about Page Layout view and Page Break
Preview in later lessons.

You can use the view buttons on the status bar
to change to the most common views.

You also can use the buttons in the Workbook
Views group on the VIEW tab to change views.

Use Zoom to magnify cells in a worksheet by any
amount up to 400%.

Change the zoom using the Zoom slider on the
status bar.
You can also change the zoom using the mouse,

touch device, or the buttons in the Zoom group on
the VIEW tab.

In the EO1Try_xx file, click the VIEW tab on the
Ribbon.

In the Show group, click one of the following:

m Formula Bar
m Headings

m Ruler

m Gridlines
Click the item you clicked in step 2 again to
redisplay it.

Double-click the VIEW tab to hide the Ribbon.

Double-click the VIEW tab again to redisplay the
Ribbon.

Click the Page Layout button in either the
Workbook Views group or near the zoom slider
to change to Page Layout view.

In the Zoom group, click the Zoom button Q.
The Zoom dialog box offers the following
magnifications:

m 200% m 25%
m 100% m Fit Selection
B 75% m Custom

m 50%

®© 6@ © © 000

Click 50%, and then click OK.
On the status bar, click Zoom In once.

On the status bar, use the zoom slider to
change the view to more than 100%.

On the status bar, drag the Zoom slider to the
middle to change the view to 100%.

On the VIEW tab, in the Zoom group, click the
Zoom to Selection button ] .

In the Zoom group, click the 100% button [ 3.

In the Workbook Views group, click the Normal
button =

Save the E01Try_xx file, and leave it open
to use in the next Try It.

Key worksheet features Zoom level

|View buttonsl |Zoom Outl |Zoom slider | |Zoom In |
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Closing a Workbook and Exiting Excel

When your worksheet is complete and you want to
close the Excel workbook, use the Close command
after clicking on the FILE tab.

You can also click the File button B on the Quick
Access Toolbar, and then click Close.

Closing a workbook file removes it from the screen
without exiting Excel.

Save a workbook before you close it or you will lose
the current data or updated entries that you made.

If you attempt to close a workbook or close Excel
before saving, you will be prompted to save the
changes.

If you have more than one file open, Excel allows

you to close and save all of the files before you exit
the program.

Exit the Excel application by clicking the Close
button * at the right end of the program’s title bar.

m Closing a Workbook and Exiting Excel

In the EO1Try_xx file, click the FILE tab on the
Ribbon.

0 Click Close.

©
(4]

If necessary, click the Save button to save your
changes to the file and close the workbook.

Click the Close button at the right end of the
program’s title bar to exit the Excel application.

Lesson 1—Practice

In this project, you will open an Excel worksheet, navigate the worksheet, change views, and close using the skills
you learned in this lesson.

DIRECTIONS

1. Click Excel 2013 and open a Blank workbook file.
2. Press [3] four times to select cell E1.

3. Press [4 four times to select cell E5.

4. Click cell H9 to make it the active cell, and then

L N o o

10.

view its cell address in the Name box.
Click HOME > Find & Select il > Go To.
In the Reference text box, type T98.

Click OK. The active cell changes to T98.

Click in the Name box to change the active cell to
the following, pressing after typing each new
cell address:

a. B1492 (row 1492, column B)

b. XFD1048576 (bottom right of worksheet)
Press + to move to cell A1.

Click cell DA4.

1.

12.

13.

14.

15.

16.

Point to the horizontal scroll bar and click the right
scroll arrow. The worksheet moves right by one
column but the active cell does not change.

Point to the horizontal scroll bar and click to the left
of the scroll box. The worksheet moves back left
but the active cell does not change.

Point to the horizontal scroll bar, and then drag the
scroll box all the way to the right. The view of the
worksheet has changed again but the active cell
does not change.

Click the down scroll arrow on the vertical scroll
bar three times. The worksheet moves down three
rows but the active cell does not change.

On the VIEW tab, in the Show group, deselect the
Formula Bar check box to hide the formula bar.

Change to the Page Layout view by clicking its
button on the status bar. Notice that the rulers
have appeared just above the column headings
and to the left of the row numbers.



17.

18.

19.

20.

21.

Chapter 1

On the VIEW tab, change to Normal view by
clicking the Normal button

In the Show group, select the Formula Bar check
box to redisplay the formula bar.

In the Zoom group, click the Zoom button O\ to
display the Zoom dialog box.

Click in the Custom box, type 150, and then click
OK. The Zoom changes to 150%, so cells appear
much larger.

Click the Zoom Out button ! on the Status bar
twice. The Zoom changes to 130%.

Lesson 1—Apply

22.

23.

24,

25.

| Learning Microsoft Excel 2013

Drag the Zoom slider to the left until the zoom is
set to 70%. The current zoom percentage shows
on the Zoom button as you drag. If you have
trouble setting the zoom to an exact percentage
using the slider, drag the slider to roughly 70%,
then click the Zoom Out or Zoom In button as
needed to jump to exactly 70%.

Drag the Zoom slider to the middle to change the
view to 100%.

Click the FILE tab and then click Close to close
the workbook. If asked to save the workbook, click
Don’t Save.

Click the Close button X at the right end of the
program’s title bar to exit Excel.

You've recently been hired as a marketing specialist for Bike Tours and Adventures, and you’ve enrolled yourself in
a class to learn to use Excel. In this project, you will start Excel, familiarize yourself with the Excel window, change
your view of the worksheet, and practice moving around the worksheet using the mouse and the keyboard.

DIRECTIONS

1.

2.

Start Excel, if necessary, and open E01Apply from
the data files for this lesson.

Save the file as E0O1Apply_xx in the location where
your teacher instructs you to store the files for this
lesson.

v Replace the text xx with your own first name and last name
or initials as directed by your teacher.
Click cell B1, type your name, and press .

Increase the zoom to 150%. Your document should
appear as shown in Figure 1-1 on the next page.
Scroll to the left and up, if necessary, to see your
name.

Hide and redisplay these screen elements:
a. Ribbon.

b. Formula bar.

c. Gridlines.

6.

10.

1.
12.
13.
14.

15.
16.

Change to Page Layout view, and then back to
Normal view.

Click HOME > Find & Select i > Go To.
In the Reference text box, type AL29.
Click OK.

Click HOME > Copy ER to copy the contents of
cell AL29.

Click HOME > Find & Select i > Go To.
In the Reference text box, type F5.
Click OK.

Click HOME > Paste [} to paste the contents of
cell AL29 to cell F5.

Press + to return to cell A1.
Save and close the file, and exit Excel.
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H - & s E01Apply_oxlsx - Excel T E - *
BT HOME | INSERT  PAGELAYOUT — FORMULAS  DATA  REVIEW  VIEW  DEVELOPER Student Name - H
-

E o i A SsE Y S B P & E iy M

Paste B T U-~- |8+ . =E== &= EMer e & Center = $ - 04 9 &0 00 Conditional Formatas Cell Insert Delete Format Sort & Find &
. ¥ a o A s e Formatting~ Table~ Styles~ - - - & Clear~ Filter - Select =
Clipboard Font [F] Alignment [F] Number F] Styles Cells Editing ~
N21 I F M
A B C D E F G H I J K L M
Name:  Student Name
Question:

How many bike tours were booked in 2013?

W 00~ AWM=

- -
- O
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Lesson 2

Worksheet and
Workbook Basics

WORDS TO KNOW

Blank workbook

A new, empty workbook
contains one worksheet
(sheet).

Clear

To remove a cell’'s
contents and/or
formatting.

Default

The standard settings
Excel uses in its software,
such as column width or
bottom alignment of text
in a cell.

Footer

Descriptive text, such

as page numbers, that
appears at the bottom of
every page of a printout.

Header

Descriptive text, such
as page numbers, that
appears at the top of
every page of a printout.

Label

Text entered to identify
the type of data
contained in a row or
column.

> What You Will Learn

Creating a New (Blank) Workbook
Entering Text and Labels

Editing Text

Using Undo and Redo

Clearing Cell Contents

Inserting a Built-In Header or Footer
Previewing and Printing a Worksheet

Software Skills Building a workbook involves creating a new file, entering

text to identify the data that will be calculated, making changes, and adding an
identifying header and footer, among other information. You also can save and print
a workbook before closing it. You'll learn these skills in this lesson.

What You Can Do

Creating a New (Blank) Workbook

You can create a new workbook file any time after you begin working in Excel.

A blank workbook file that you create has one worksheet by default, just like
the blank workbook that appears when you start Excel.

Use the Blank workbook choice in the Backstage view to create a blank file. Click
the FILE tab > New > Blank workbook.

v You can press +[N] at any time to create a blank file without displaying the
Backstage view.

You can create a workbook using a template in the the Backstage view. You can
choose from sample templates installed with Excel, or templates in a variety of
categories on Office.com.

During the current work session, Excel applies a temporary name to any new
workbook you create. The first blank workbook that appears is named Book1
until you save it with a new name. Subsequent blank files you create are named
Book2, Book3, and so on.
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m Creating a New Workbook in Excel

From the Windows Start screen,
click the Excel 2013 program tile
and then click Blank workbook.
Excel starts and opens a blank
workbook file.

v If your keyboard has a Windows
key (a key with the Windows logo on
it), you can press that key at any time

Click Blank worksheet. A second
new, blank workbook appears,
with its sequentially numbered
temporary name, Book2.

Save the file as ETry02_xx in
the location where your teacher
instructs you to store the files for
this lesson.

to display the Start menu. @© Leave the file open for the next
@ Click FILE > New > Blank Try It.
workbook.

v Throughout this book, you will see
instructions provided in a sequence
format; for example, “Click FILE >
New” means to click the FILE tab and
then click New.

The new file shown in title bar

Book2 - Excel

Neutral

General - w

@iﬂ Normal Bad Good
$-9% 2 W Conditional Format as |[[#}1= ¢ &= ]]

Explanatory ... |Input Linked Cell
Formatting = Table -

MNumber [Pl Styles

Entering Text and Labels

m The first character entered in a cell determines what type of cell entry it is—a
label or text, number, or formula.

m If you enter an alphabetical character or a symbol (* ~!1# % A& * () _\I{};:"”
<>, ?) as the first character in a cell, you are entering a label.

m A label may be text data, such as the labels: Blue, Sally Smith, Ohio, or Above
Average.

m Or, a label may be used to identify data in the row beside it or the column below
it, such as the labels: Sales, Qtr 1, or January.

m As you type a label in a cell, it appears in the cell and in the formula bar.
m To enter the label in the cell, type the text and then do any of the following to

finalize the entry: press the key, an arrow key, the key, click another cell,

or click the Enter button «* on the formula bar.

v To enter multiple lines in a cell such as Overtime above and Hours below, type Overtime, press
+ . Type Hours on the second line in the cell and press to finalize the entry.

Preview
To see how a worksheet
will look when printed.

Redo

The command used to
redo an action you have
undone.

Text

An alphanumeric entry in
a worksheet that is not a
cell or range address.

Undo

The command used to
reverse one or a series
of editing actions.
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® You also can press + to finish a cell entry m |f you enter a lot of text in a cell, that text may not
and leave the current cell selected. This is a good fully display in the formula bar. You can expand the
technique to use if you later need to copy the cell’s formula bar (make it taller) by clicking the Expand
contents. Formula Bar button ~| at the right end of the
The default width of each cell is 8.43 characters in formula bar.
the standard font (Calibri, 11 point). m A label automatically aligns to the left of the cell,

m A label longer than the cell width displays the making it a left-justified entry.

complete text only if the cell to the right is blank, or
if you make the column wide enough to fit the entry.

m Entering Labels (Text)

In the E02Try_xx file, click cell A1, type Client
Survey, and press twice.

Type Client ID, and press twice.

Type the following entries, pressing after
each one:

Click cell E4. Type A Rating, and press [=].

Type B Rating and C Rating in the next two
cells to the right, pressing to complete each
entry.

Click the Save button EH on the Quick Access
Toolbar to save the file, and leave it open for the
next Try It.

(4]
(5]

Was the room temperature appropriate?
Were the staff members cordial?

Was your appointment administered on time?
Were your treatments explained in advance?
Were your treatments explained in advance?
Were you offered a beverage?

The file with label entries
B@HS -

HOME IMNSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
"D ‘_}E’C“t Calibri -t -|A s E=2 ®- EWepTe
BRcopy -
Pa-ste ' Format Painter B I U- H. &O-A- === & 35 [E Merge & Center
Clipboard T Font P Alignment
[ RN * ||
A E C D E F G | H |
1 |Client Survey
2
3 |Client ID:
4J A Rating B Rating CRatingl .l
5 |Was the room comfortable?
& |Were the staff members cordial?
7 |Did your appointment start on time?
8 |Were your treatments explained in advance?
9 |Were your treatments explained in advance?
10 |Were you offered a beverage?
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Editing Text

m As you type data in a cell, if you notice a mistake
before you press [==] (or any of the other keys that
finalize an entry), you can press the g key to
erase characters to the left of the insertion point.

Before you finalize an entry, you can press the
key or click the Cancel button 2 on the formula
bar to cancel it.

After you enter data, you can make the cell active
again (by clicking it, pressing an arrow key, etc.)
and then type a new entry to replace the old one.

m Editing Text

Chapter 1

You can double-click a cell in which the entry has
been finalized to enable in-cell editing (also called
Edit mode) and then make changes to only part of
the entry.

When in Edit mode, in a cell with data, the word
EDIT displays at the left end of the status bar.

Use the [Backseace], , and other keys and selection
techniques (as in Word) as needed to select and
replace data.

In the E02Try_xx file, click cell A9. This cell has
a repeated entry that you want to replace.

Type Were you relaxed during the process?,
and press + to finish the entry.

Click cell A5 and press [. Drag over
temperature appropriate to select those words,
type comfortable, and press [ .

© ©®© 0 0O

the insertion point is at the beginning of the cell
entry. Press and hold while pressing
three times to select Was. Type Did.

Editing a text entry

FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
Ruler Formula Bar Q I:\:) 51
mmano N =
MNormal Page Break Page Custom Gridlines Zoom 100% Zoomto New

N N Headings ' N
Preview Layout Views Selection | Window

‘Workbook Views Zoom

Show

AT 21 x v
A B C |
Client Survey Current cell contents
Client ID:

ARating BRating CRating
Was the room comfortable?
~ |Were the staff members cordial?

_|Was your appointment administeredhon time?
‘Were your treatments explained in advance? _
‘Were you relaxed during the process? Selected word

Were you offered a beverage?

0N o W e W

23

Double-click cell A7, and press to make sure

(~J )

HOME

Normal Page Break Page Custom ] Gridlines [ Headings

A9 - b

T R R T

With the cell still in Edit mode, double-click
administered to select it.

Type start, and press =] .

With cell A8 selected, click in the formula bar to
the right of the word explained, press and
click to the right of the word advance, press

, and then press . This finishes the
current edits.

Press + [§] to save your changes to the
E02Try xx file, and leave it open to use in the
next Try It.

The edited text

INSERT

B

PAGE LAYOUT FORMULAS DATA REVIEW VIEW

Ruler [¥] Formula Bar Q [E) @ 51

Zoom 100% Zoomto

Preview Layout Views Selection Wmdow

‘Workbook Views Show Zoom

‘Were you relaxed during the process?

A | B C D E F G H
Client Survey

Client 1D;
ARating BRating CRating
Was the room comfortable?
Were the staff members cordial?
Did your appointment start on time?

_|Were your treatments explained?
Were you.relaxed during the process?

Were you offered a beverage?

23
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v The default number of Undo actions is 25.

m The Undo button’s name changes to reflect the
most recent editing action.

® You can also redo (reinstate any action you've
undone in error) up to 100 reversed actions using
the Redo button <.

m Both the Undo and Redo buttons include a drop-
down list that enables you to undo or redo multiple
edits at once.

m Use the Undo button © on the Quick Access
Toolbar to reverse any editing action.

B Some actions can’'t be undone (such as saving a
workbook); in such cases, the Undo button will not
be available and will be grayed out.

m You can reverse up to 100 previous editing actions
with Undo.

In the E02Try_xx file, click cell E4.
Type Yes, and press [m8].

Click the Redo button € on the Quick Access
Toolbar.

In cell F4, type No and press + to finish
the entry.

On the HOME tab, in the Font group, click the

Click the Undo drop-down arrow on the Quick
Access Toolbar, and click the third choice in the
menu, which should be Typing ‘Yes’ in E4.

Click the Redo button € on the Quick Access

® © 00
© e © 0

Bold button B . .
Toolbar twice.
. ﬁ .
Click the Undo button on the Quick Access Save the E02Try_xx file, and leave it open
Toolbar. .
to use in the next Try It.
Cleuring Cell Contents m Right-click a selected cell or range and click Clear

Contents on the shortcut menu to remove the

m Press or click the Cancel button 2% on contents of the selected cell or range.

the formula bar to clear a cell’'s contents before m You can clear the formatting of a selected cell or
finalizing any cell entry. range by clicking HOME > Clear > Clear Formats.
m To erase a finished cell entry, select the cell and m Clear All will clear the selected cell or range

then press .

m You also can use the Clear button € Clear~ in the
Editing group of the HOME tab to delete the cell’'s
contents or to selectively delete its formatting or
contents only.

m Clearing Cell Contents

o In the E02Try_xx file, drag over the range E4:G4 Q
to select it.

completely (format, contents, etc.). Click HOME >
Clear > Clear All.

Click the Undo button € on the Quick Access
Toolbar.

With cell G4 still selected, click HOME > Clear
& Clear- > Clear All.

v The above instruction means to drag the mouse from cell 9
E4 across to cell G4. The shorthand E4.G4 is the address

for the range of cells. Lesson 6 provides more detail Drag over the range E4:F4 to select it.

Click HOME > Clear # cClear~ > Clear Formats.

about selecting and working with ranges.

In the Font group of the HOME tab, click the
Bold button B .

Click cell G4, and press [2e] .

Save the E02Try_xx file, and leave it open
to use in the next Try It.
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When you want to repeat the same information at
the top of each printed page, create a header.

When you want to repeat the same information at
the bottom of each printed page, create a footer.

Header and footer information only appears in the
Page Layout view or the printed worksheet.

You can select a predesigned header or footer or
create customized ones.

To create a predesigned header or footer, click the
INSERT tab, go to the Text group, and the Header
& Footer button = to display the HEADER &
FOOTER TOOLS DESIGN tab. Then click either the
Header [7] or Footer |2 buttons, and choose one of
the predefined headers or footers.

To customize the header/footer from there, type text
in the appropriate section of the header or footer
area: left, center, or right.

Chapter 1

v From here on, you will need to add a header with your name,
the current date, and a page number print code to all the
project workbooks.

You can also click buttons in the Header & Footer
Elements group to insert print codes for the page
number, total pages, current date, current time, file
path, file name, or sheet name.

v A print code is a set of characters that represent an element.
For example, &[Page] is the print code for a page number.

You can also insert a graphic or picture (such as a
company logo) in a header or footer.

You can change the font, font style, and font size
of the header or footer using the tools on the HOME
tab.

Press to finish editing a custom header or
footer and close the HEADER & FOOTER TOOLS
DESIGN tab.

m Inserting a Built-In Header or Footer

(X ~)

In the E02Try_xx file, click cell A1.

On the INSERT tab, in the Text group, click the
Header & Footer button [-.

On the HEADER & FOOTER TOOLS DESIGN
tab, in the Header & Footer group, click the
Header button [7], and then click E02Try_xx,
Page 1 on the menu. The header appears in
PAGE LAYOUT view.

v If you've entered your name as the user name in Excel’s
options, you can choose a predefined header or footer
that includes your name.

Click INSERT > Header & Footer [1.

On the HEADER & FOOTER TOOLS DESIGN
tab in the Navigation group, click the Go to
Footer button [ .

(6]

© © & 00

With the insertion point in the center box of the
footer, type your name, and then press to
move the insertion point to the right box.

On the HEADER & FOOTER TOOLS DESIGN
tab in the Header & Footer Elements group,
click the Current Date button 7] to insert a code
that will display and print the current date.

Press to finish the entry in the right box.

Press to finish working with the header and
footer.

Review the footer you created, then scroll up
and view the header.

Click VIEW > Normal
view.

to return to Normal

Save the E02Try_xx file, and leave it open
to use in the next Try It.
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Previewing and Printing a Worksheet m Before you print a worksheet, you have the
opportunity to review its appearance in the
m You may print the selected worksheet(s), an entire Backstage view.
workbook, or a selected data range. ®m You also can specify print options in the Backstage
m You can preview a worksheet before you print it. view.
Previewing enables you to see a more accurate m If you decide not to print, click the HOME tab to
representation of how the worksheet will look when leave the Backstage view.
printed, so you don’t waste paper printing a sheet
with the wrong settings.
v In Lesson 20, you learn how to print an entire workbook and
a selected range.
m Previewing and Printing a Worksheet
o In the E02Try_xx file, click FILE > Print. 9 The various print settings appear in the Print
@ Review the document preview at the right side pane area of the Backstage view.
of the Backstage view. The preview shows the 0 Make sure that Print Active Sheets is selected
placement of headers and footers and all entries under Settings.
on the page. e With your teacher’s permission, click the
v If the worksheet you were printing consisted of multiple Print button. Otherwise, click the HOME tab.
pages, you could use the buttons at the lower left fo o Save and close the file, and exit Excel.
move between them.

Print Preview

E02Try o - Excel 7T - 0O X

Print

Copies: |1 :

L=

Print

ED2Try o Pagel
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Printer . cleneio:

Was theroom comfortable?
Were the staff members cordial?
‘Wasyour appentment administered on time?

Yes Ne

_/ Snagit11 .
P Ready

Printer Properties

Were your trestments explained in advance?
. ‘Were you related during the proces?
Settings Were you offered a bever sge?

ﬁ Print Active Sheets
Only print the active sheets
Pages: 2| to =
Collated
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|:| Letter .
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Left 0.7 Right 0.7
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Lesson 2—Practice

Chapter 1

In this project, you will create a new Excel worksheet, insert a built-in header, and undo and redo editing actions
using the skills you learned in this lesson.

DIRECTIONS

1.
2.
3.

10.
11.
12.
13.

14.
15.
16.
17.

Start Excel, if necessary.
Click Blank workbook.

Save the blank file that appears as E02Practice_xx
in the location where your teacher instructs you to

store the files for this lesson.

Click INSERT > Header & Footer [2.

In the HEADER & FOOTER TOOLS DESIGN tab,

click Header [, and click the Page 1 choice.

Click INSERT > Header & Footer 2.

. Type your name in the left header box, and press

twice to move to the right header box.

In the HEADER & FOOTER TOOLS DESIGN tab,
click Current Date 7] to insert a date printing
code.

Press and then to finish creating the
header.

Click VIEW > Normal £
Type Invoice in cell A1, and press twice.
Type Remit To: and press [Ts].

Type Serenity Health Club, press , and press
if needed to select cell B4.

Type 200 W. Michigan Ave. and press .

In cell B5, type Chicago, IL 60614, and press .

In cell B6, type 606-555-1200, and press [ .

Click cell A8, and type the following three entries,
pressing after each:

a. Time:
b. Number:
¢. Due Date:

18.

19.

20.

21.

22.
23.

24,

25.

26.

27.

28.

29.

Press again to select cell A12, and make the
following two entries, pressing after each:

a. Client ID:
h. Client:

Click the Undo button © on the Quick Access
Toolbar twice to undo the previous two entries.
Click the Redo button ¢ on the Quick Access
Toolbar twice to redo your entries.

Scroll up and drag over the range B3:B6 to select
it.

Click HOME > Clear # clear- > Clear Contents.
Click the Undo button © on the Quick Access
Toolbar.

Click cell A8, type Date:, and press to replace
that cell’s entry.

With cell A9 selected, press [, press +

to move the insertion point to the beginning of the
cell, type Invoice, press , and press [=] .
Drag over cell A10’s entry in the formula bar,

type Terms:, and click the Enter button ¥ on
the formula bar to replace the entry. The finished
worksheet appears as shown in Figure 2-1 on the
next page.

Click FILE > Print.

With your teacher’s permission, click the Print
button. Otherwise, click the Back button to exit
the Backstage view.

Click the Save button H on the Quick Access
Toolbar, and then click the Close button * at the
end of the program’s menu bar to exit Excel.
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Lesson 2—Apply

You are the Accounts Receivable Supervisor at the Serenity Health Club. A member has charged several services
but has not yet paid for them. You need to create an invoice detailing the charges.

DIRECTIONS 5. Enter the following data in cells B8:B10:
1. Start Excel, if necessary, and open E02Apply from a. 1/3114

the data files for this lesson. b. 546
2. Save the file as EO2Apply_xx in the location ¢. Due on receipt

where your teacher instructs you to store the files
for this lesson.

3. Add a header that has your name at the left, the
date code in the center, and the page number at
the right.

4. Change back to Normal view.

e

Click cell A9 and replace Number with No..

7. Click cell B10, and then click HOME > Align Right
= in the Alignment group.

Clear the formatting you just applied in cell B10.

9. Click the Undo button £ on the Quick Access
Toolbar to undo the formatting change.

*
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10. Change the entries in cells A12:A13 to the 14. Scroll down. Notice that the worksheet already has
following: calculations built in, so it calculates values in the
a. Member ID: Amount column and Total cell for you.
b. Member: 15. You have been informed that the rate for personal

training has changed. Click the Undo button € on

11. Click cell B12, and enter A1054. the Quick Access Toolbar, and then enter a rate of

12. Enter the following data in cells B13:B15: 55 in cell C20.

a. Joy Wen 16. Click FILE > Print to preview the file in the

b. 12 W. 21st St. Backstage view.

¢. Chicago, IL 60602 17. With your teacher’s permission, click the Print
13. Make entries in the portion of the invoice that button. Otherwise, click the Back button [G) to exit

calculates the invoice charges, as follows: the Backstage view. Submit the printout or the file

a. cell A18: 2 for grading as required.

b. cell B18: Massage Hours 18. Save and close the file, and exit Excel.

c. cell C18: 45

d. cell A19: 1

e. cell B19: Facial

f. cellC19:75

g. cell A20: 3

h. cell B20: Personal Trainer Hours

cell C20: 50
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Lesson 3

Adding Worksheet Contents

> What You Will Learn

WORDS TO KNOW

AutoComplete

A feature used to
complete an entry based
on previous entries made
in the column containing

Opening an Existing Workbook and Saving It with a New Name
Entering and Editing Numeric Labels and Values

Using AutoComplete

Using Pick From List

Using AutoCorrect

Checking the Spelling in a Worksheet

Software Skills Save a copy of a workbook with a new name to use it as the
basis for another workbook. You also need to know how to enter numeric values,
which are the basis for calculations. When entering data, take advantage of the

the active cell.

AutoCorrect

A feature used to
automate the correction
of common typing errors.

Numeric label

A number entered in the
worksheet as a label,
not as a value—such as
the year 2014 used as a
column label.

Pick From List

many time-saving features Excel offers. Excel’'s AutoComplete feature, for example,
automatically completes certain entries based on previous entries that you've made.
AutoCorrect automatically corrects common spelling errors as you type, while the
spelling checker checks your worksheet for any additional errors.

What You Can Do

Opening an Existing Workbook and Saving It with a New Name

, m When you have saved and closed a workbook file, you can open it from the

A shortcu_t used t‘? insert same disk drive, folder, and file name you used during the save process.
repeated information. ) )

m When Excel starts, you can access a recently used file from the Recent list on
Spelling checker the left. Click a file to open it.
A tool used to assist you ) , )
in finding and correcting v You gqn also gllck Open Other Workbooks to go to the Backstage view and select a file from a
typographical or spelling specific location.
errors. m Click FILE > Open to display the Backstage view and access recently opened
Value workbooks, the Skydrive, and Computer. The Recent Workbooks window is
A cell entry that consists displayed by default. Click a workbook or location to open it.
of a number and numeric m Click SkyDrive to access files from Microsoft’s virtual storage location.
formatting only. m Click Computer to access files from a specific location on your computer. Click

Browse (@ to open the Open dialog box.
m In the Open dialog box, use the arrows in the text box at the top to navigate the

disks, libraries, and folders on your computer.
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®m You also can use the Navigation pane at the left m Click the Change your view button in the Open
to go to the location of the workbook. Clicking the dialog box to preview a file, change the list to
triangle beside any location displays the location’s display file details, or display the properties of a file.
contents, and clicking again hides its contents. ®m You can pin a recently used workbook or location to
m The default file location, the Documents library in the Recent lists so it is always easily accessible.
Windows 8, appears in the Navigation pane by - ® A newly opened workbook becomes the active
default. You can navigate to other libraries, favorite workbook and hides any other open workbook.

locations (under Favorites), locations on your
computer, locations on the network, and locations on
the Skydrive. You can also navigate to Homegroup
(local network) locations if that feature is enabled.

m Opening an Existing Workbook and Saving It with a New Name

Start Excel. @ Click FILE > Save As.

Click FILE > Open. 0 Navigate to the folder where your teacher

Navigate to and select the folder containing the instructs you to store the files for this lesson.

data files for this lesson. Click in the File name text box, and edit the

Click the E03Try file. The file appears onscreen. D S 10 e ST

Click the Save button to finish saving the file,
and leave it open to use in the next Try It.

Add a header that has your name at the left, the
date code in the center, and the page number
code at the right, and change back to Normal
view.

Renaming the file

* 1 1 » Solutions v O Search Solutions

Crganize = MNew folder

~ Date modified
¢ Favorites
B Desktop Mo iterms match your search,
& Downloads
|| Dropbox
':E-'-_'j" Recent places

& Libraries
@ Documents

J' Music

[E Dirturar

] New file name
File name:

Save as type: | Excel Workbook

Authors:  Add an author Tags: Addatag

[] Save Thumbnail

& Hide Folders
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Entering and Editing Numeric Labels
and Values

m A cell contains a value when its first character
begins with either a number or one of the following
symbols (+, —, =, $).

m Type the value, and then do one of the following to
enter it in the cell:

e Press .
e Press an arrow key.
e Click the Enter button & on the formula bar.
e Click another cell.
m The default cell format in Excel is General.

m To display any number in a different format, apply
the number format you want to use, as explained in
Lesson 4.

m If you see pound signs displayed in a cell instead of
a number, widen the column to display the value.

m You can enter some numbers with their formatting
and Excel will recognize them as numbers,
including:

e Thousands: You can enter numbers with
thousands separators, as in 1,543,009.24
e Currency values: You can enter values with
currency formatting, as in $1,299.60.
Percentages: You can enter a percent symbol to
specify a percentage, as in 54%.

When you enter numbers that contain hyphen
formatting—such as Social Security numbers,
phone numbers, and Zip codes—Excel treats

the entries as text, and they cannot be used in
calculations.

A numeric label, such as a year number above

a column of data that identifies the data’s timing,

is @ number that typically will not be used in
calculations.

Begin the entry of a numeric label with an
apostrophe (') as a label prefix to indicate that the
number should be treated as a label (text) and not
as a value. The entry will align at the left of the cell,
unlike other value entries, which align right.

Although the label prefix (') is shown on the formula
bar, it is not displayed on the worksheet or printed.

When you enter a value with an apostrophe, Excel
displays a green triangle in the upper left-hand
corner of the cell. Select the cell again, and an
error button appears. You can:

e Click the button and click Ignore Error to confirm
that the number is really a label.

e Click the button and click Convert to Number
if the apostrophe was entered in error and the
entry should be treated as a number.

Edit a cell with a value or numeric label using the
same techniques as editing a cell with a text entry.

m Entering and Editing Numeric Labels and Values

In the EO3Try_xx file, click cell A12, type Roll,
and press [18].

Type Spelt and press [Té].

Type 8 and press [Tz&].

Type .35 and press [ .

In cell A13 type Mini Roll, and press [12&].

(6]
(7]

(8]

Type Oat and press [m8].

Type 24 and press [28]. Notice that the number
left aligns in the cell and a green triangle
appears.

Click cell C13, click the Error button, and click
Convert to Number. The entry right aligns in
the cell.

(continued)
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m Entering and Editing Numeric Labels and Values (continved)

Converting a numeric label to text

© Press @, type $.20, and press (s + [ .
@ Click cell D8, type $1.15, and press (== to Flour Quantty Price Value
replace the current entry. Wheat Values entered $0.25 $3.00
. e White | i formatting [ 095 $2.85
@ Click cell C10, press [, press [usksece], type 8, i White 91 cobs 520
and press . nt White 24 £0.30 £7.20
@  Save the E03Try xx file, and leave it open to :Mie  Wheat 24 s020  sa.Bo
in the next Try It Spelt £ 5035 s2.80
U1 : sl Oat |40 v|24 I £0.00
Error button Mumber Stored as Text $0.00
$0.00
Convert to Mumber, 50.00
Help on this error
Ignore Error
Using AutoComplete m Type part of the label. If an entry with the same
characters has already been entered in the column
m  When you need to repeat a label that has already above, a suggestion for completing the entry
been typed in the same column, the AutoComplete appears in black.
feature allows you to enter the label automatically. m To accept the AutoComplete suggestion, press
or . Otherwise, continue typing the rest of the

entry.

m Using AutoComplete

In the EO3Try_xx file, click cell A14. 0 Save the E03Try_xx file, and leave it open
to use in the next Try It.

Type Pan. An AutoComplete suggestion appears

in the cell.

Press (78] to accept the AutoComplete entry and A T R s ST s e
move to cell B14. 11 |Pain de Mie Wheat

Type Whe, and press to accept the 12 Roll Spelt

AutoComplete entry and move to cell C14. 13 MiniRol oat

Type 8, and press (1.
Type $.70, and press [xs .

@® ©0 © ©0

Ilsing Pick From List v The cells in the list and the cell to be typed must be next to
each other and in the same column. Use the Undo button
m If several labels are entered in a list and the next € on the Quick Access Toolbar to reverse any editing
items to be typed are repeated information, you action.

also can use the Pick From List feature to make
entries. Right-click a cell and then click the Pick
From Drop-down List command on the shortcut
menu.

m Click the desired choice in the list of entries that
appears to enter it in the cell, and then press
or to move to the next cell, if needed.
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m Using Pick From List

In the EO3Try_xx file, right-click cell A15,
and click Pick From Drop-down List.

In the list that appears, click Roll.

Right-click cell B15, and click Pick From
Drop-down List.

000 ©

In the list that appears, click White, and then
press [Ta8].

Type 36, and then press [18].
Type $.23, and then press [18].

Save the E03Try_xx file, and leave it open
to use in the next Try It.

Using AutoCorrect

m If you type a word incorrectly and it is in the
AutoCorrect list, Excel automatically changes the
word as you type.

m AutoCorrect automatically capitalizes the names of
days of the week; corrects incorrectly capitalized
letters in the first two positions in a word; and
undoes accidental use of the Caps Lock key.

m Using AutoCorrect

When certain changes are made with AutoCorrect,
you’re given an option to remove the corrections by
clicking the arrow on the AutoCorrect Options button
that appears, and selecting the action you want.

You can add words to the AutoCorrect list that you
often type incorrectly. Click FILE > Options. In the
Excel Options dialog box, click Proofing in the list at
the left. Click the AutoCorrect Options button. Type
entries in the Replace and With text boxes, and
then click the Add button. Repeat as needed, and
then click OK to close both dialog boxes.

In the EO3Try_xx file, click cell A16.

Type Cafe Biscotti, and press [m8]. Notice that
when you press to finish the first word,
Excel adds the accent to correct its spelling.

Type O, and then press [m8]. AutoComplete fills
in the word Oat for you.

Type 92, and then press [T8].
Type $.28, and then press [m8].
Click FILE > Options.

In the Excel Options dialog box, click Proofing in
the list at the left.

OO0 ©® ©0

©

Click the AutoCorrect Options button.

©e ©

®©@0 0

Type quantty in the Replace text box, and
quantity in the With text box.

Click the Add button.
Click the OK button twice.

v If your teacher asks you to, reopen the AutoCorrect
Options dialog box, select the quantty correction, and
click Delete.

Click cell A18 to select it.

Type quantty, and then press . Notice that
AutoCorrect corrects the text you typed.

Click Undo.

Save the E03Try_xx file, and leave it open
to use in the next Try It.

Checking the Spelling in a Worksheet

m To check the spelling of text in a worksheet and
obtain replacement word suggestions, use the
spelling checker feature.

m Start the spelling check from cell A1 to ensure it
checks all sheet contents.

v If you don’t start the spell check from the beginning of
the worksheet, Excel completes the spell check and then
displays “Do you want to continue checking at the beginning
of the sheet?”

v/ Press + to go to the beginning of the worksheet.
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m To start the spelling checker, click the REVIEW v Pressing [&2] also starts a spelling check.
tab and in the Proofing group, click the Spellin
b A.;Ic g group, ¢l Spelling v Checking spelling in Excel works much as it does in Word.
utton .
m Checking the Spelling in a Worksheet

In the EO3Try_xx file, click cell A1. 0 At the next misspelling, Pannini, make sure the

. o BT proper spelling is selected in the Suggestions
Cllek RIEVIEN = Spellie b list, and click the Change All button.

At the first misspelling, Quantty, make sure the o
proper spelling is selected in the Suggestions
list, and click the Change button.

Save and close the file, and exit Excel.

Lesson 3—Practice

In this project, you will enter and edit text, undo and redo editing actions, and check the spelling in a worksheet.

DIRECTIONS 10. Click cell A8, and type the following cell entries
exactly as shown, pressing after each (note

1. Start Excel, if necessary. AutoCorrect in action again):

2. Click Blank workbook to open a new file.

a. Cafe Latte
3. Save the file as EO3Practice_xx in the location
; : b. Java Cafe
where your teacher instructs you to store the files .
for this lesson. ¢. Villige Green
date code in the center, and the page number code exactly as shown, pressing after each:
at the right, and change back to Normal view. a. Bagels
5. Type Whole Garins Bread (r) in cell A1, and press b. Croissants
. (Type the entry exactly as shown; errors will ¢. Wheat Bread

be corrected later.) Notice that the AutoCorrect
feature changes the (r) entry to a register mark: ®.

Press three times.

12. Click cell C8, and type the following cell entries
exactly as shown, pressing after each:

6.

a. 325
7. Type Bakery Schedule, and press . b. 100
8. Type 10/10/14, and press twice. c. 25
9. Type the following cell entries, pressing after .

13. Click cell D8, and type the following cell entries

each: exactly as shown, pressing after each:
a. Customer
| a. 300
| (t;mN ded b 100
- Wity Neede c. 25

b
c
d. Qty Shipped
e. Qty to Bake



. Click cell A11, type J, and press 8] to complete

. Type the following cell entries, pressing 8] after

Chapter 1

the cell entry using AutoComplete.

19.

20.

| Learning Microsoft Excel 2013

At the next misspelling, Qty, click the Ignore All
button.

At the next misspelling, Villige, make sure that

each: Village is selected in the Suggestions list, and
a. Pastries then click the Change button.
b. 150 21. In the message box that informs you that the
125 spelling check is complete, click the OK button.
C. The finished spreadsheet appears as shown in
16. Click cell A1. Figure 3-1.
17. Click REVIEW > Spelling ¥ . 22. With your teacher’s permission, print the
18. At the first misspelling, Garins, make sure that worksheet. Submit the printout or the file for
Grains is selected in the Suggestions list, and grading as required.
then click the Change button. 23. Save and close the file, and exit Excel.
HOME | INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  DEVELOPER
“D E?E’ Calibri I AN =8 ¥ EWepTet |General -
E@ -
Paste o B I U-~- Hi- @)*A' = = = EE Merge&'_Center - % - %% 2 500 :
Clipboard Font Pl Alignment Pl MNumber Pl
K31 - &
A B C D E F G H

W00 = R WM =

— ot b bk
S TR L PR =]

Whole Grains Bread ®

Bakery Schedule

10/10/2014
Customer ltem Oty Needed Qty Shipped Qty to Bake
Café Latte Bagels 325 300
Java Café Croissants 100 100
Village Green Wheat Bread 25 25
lava Café Pastries 150 125
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You're the team leader at Whole Grains Bread, and you need to complete the baking schedule for today so the
other chefs will know what needs to be done for delivery tomorrow. You want to compare today’s schedule with
yesterday’s, in order to compile a list of any items that were not completed on time. Those items will be given the
highest priority.

DIRECTIONS

1.

2.

Start Excel, if necessary, and open the EO3Apply
file from the data files for this lesson.

Save the file as EO3Apply_xx in the location
where your teacher instructs you to store the files
for this lesson.

. Add a header that has your name at the left, the

date code in the center, and the page number code
at the right, and change back to Normal view.

In cell A12, use Pick From Drop-down List to
enter Village Green.

Click cell A13, and make the following entries,
using AutoComplete where applicable and
pressing after each:

a. Mike’s Steak House
b. Gribaldi’s Risorante
¢. Java Café

d. Café Latte

e. Village Green

Click cell B12, and make the following entries
exactly as shown, using AutoComplete where
applicable and pressing after each:

a. White Bread

b. Pastry Assortment
¢. Garlic Bread

d. Muffin Assotment
e. Muffin Assortment
f. Wheat Rolls

Click cell C12, and make the following entries,
pressing after each:

a.9

h. 200
c. 125
d. 100
e. 225
f. 700

10.
11.
12.
13.
14.

15.

16.

17.

18.

19.

20.

Click cell D12, and make the following entries,
pressing after each:

a. 9
b. 200
. 125
. 100
. 175
650
Click cell D10, and change the entry to 0.
Click cell D13, and change the entry to 160.
Click cell D15, and change the entry to 48.
Click cell A1.
Check the spelling in the worksheet.

At the first misspelling, Qty, click the Ignore All
button.

At the next misspelling, Gribaldi’s, click the Ignore
Once button.

At the next misspelling, Risorante, edit the entry
to read Ristorante, and then click the Change
button. Click Yes to change the word even though
it's not in the dictionary.

At the next misspelling, Assotment, make sure the
right correction is selected in the Suggestions list,
and click the Change button.

In the message box that informs you that the
spelling check is complete, click OK.

With your teacher’s permission, print the
worksheet. Submit the printout or the file for
grading as required.

Save and close the file, and exit Excel.

- 0o o2 o



FILE HOME INSERT

Chapter1 | Learning Microsoft Excel 2013

PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER

& - jp—
B o | Calibri -l AN =E=E &  EwepTe General - ?[
By - :
Paste o B I U - D A === &3 EHMegediCenter ~ $ - % | 5028 Condit
Formati
Clipboard ™ Font I Alignment [F} MNumber [F}
L19 e F
A B C D E
1 Whole Grains Bread ® m
: e
3
4 |Bakery Schedule
5 10/10/2014
6
7 |Customer Item Qty Needed Qty Shipped Qty to Bake
& |Café Latte Bagel Assortment 325 300 25
9 |lawva Café Croissants 100 100 0
10 Village Green Wheat Bread 25 0 25
11 |Java Cafée Pastry Assortment 150 125 25
12 Village Green White Bread 9 9 0
12 Mike's Steak House Pastry Assortment 200 160 40
14 | Gribaldi's Ristorante Garlic Bread 125 125 4]
15 |Java Café Muffin Assortment 100 13 52
16 |Café Latte Muffin Assortment 225 175 50
17 |Village Green Wheat Rolls 700 650 50

—
=]
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Lesson 4

Worksheet Formatting

> What You Will Learn

Choosing a Theme

Applying Cell Styles

Applying Font Formats

Merging and Centering Across Cells
Applying Number Formats

Software Skills When you change the appearance of worksheet data by
applying various formats, you also make that data more attractive and readable.

What You Can Do

Choosing a Theme

m To make your worksheet readable and interesting, you can manually apply
a set of formats.

m You manually format data by selecting cells and then clicking options on the
HOME tab, such as the Font and Font Color A - buttons.

m Using too many manual formats can make the worksheet seem disjointed and
chaotic.

m To make your worksheet more professional-looking, use a theme to apply a
coordinated set of formats.

m By default, the Office theme is applied to all new workbooks; if you select a

different theme, the fonts and colors in your workbook will automatically change.

m If you don’t want to change the fonts in your worksheet, you can apply just the
theme colors from a theme.

m Likewise, you can change theme fonts and the theme effects applied to graphics
without affecting the colors already in your worksheet.

B You select a theme from the Themes gallery in the Themes group on the Page
Layout tab.

m As you move the mouse over the themes shown in the gallery, the worksheet
automatically shows a Live Preview of the data.

m When you type data in a cell, it's automatically formatted using the font in the
current theme.

WORDS TO KNOW

Accounting format

A style that vertically
aligns dollar signs ($),
thousands separators (,),
and decimal points.

Cell style

A combination of a font,
text color, cell color,
and other font attributes
applied to a single cell.

Comma format

A style that displays
numbers with a
thousands separator (,).

Currency format

A style that displays
dollar signs ($)
immediately preceding
the number and includes
a thousands separator (,).

Fill
A color that fills a cell,
appearing behind the data.

Font
The typeface or design
of the text.

Font size

The measurement of the
typeface in points (1 point
= 1/72 of an inch).
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Format

To apply attributes

to cell data to change
the appearance of
the worksheet.

Live Preview

A feature that shows you
how a gallery formatting
choice will appear in the
worksheet when you
move the mouse pointer
over that choice.

Merge and Center

A feature that enables
you to automatically
combine cells and center
the contents of the
original far left cell in the
new cell.

Number format

A format that controls
how numerical data is
displayed, including the
use of commas, dollar
signs (or other symbols),
and the number of
decimal places.

Percent format

A style that displays
decimal numbers as a
percentage.

Theme

A collection of
coordinated fonts, colors,
and effects for graphic
elements, such as charts
and images, that can

be quickly applied to all
sheets in a workbook.

m You can apply a cell color (called a fill) or a text color. Click the down arrow on
the Fill Color &- or Font Color A - buttons in the Font group of the HOME tab,
and then click one of the choices under Theme Colors.

m If you apply a theme color to text or as a fill and later switch themes, Excel

updates the color according to the new theme.

m If you choose one of the standard colors or use the More Colors option, the
selected color will not change if you later change the theme.

m Choosing a Theme

©

(5]

Start Excel.

Open the E04Try file from the
data files for this lesson.

Save the file as E04Try_xx in
the location where your teacher
instructs you to store the files for
this lesson.

Add a header that has your name
at the left, the date code in the
center, and the page number
code at the right, and change
back to Normal view.

On the PAGE LAYOUT tab, click
the Themes button 4.

Previewing a theme

H - ¢ E04Try

h HOME INSERT PAGE LAYOUT FORMULAS DATA REV

A B colorze_ER__[BY 7w == =

1 [&]Fanss| Mouse Pointer SD |,,:';f o E“m jEE'%

= @l ver 3 theme . Tiles

Office = Live Preview |[*
Aa I AO of the theme

Office Facet

%

Price Number Solc

lon Board...

225 1

Ac Aa Aa Aa — =
— . : e I ...... I = o
P

Banded Basis Celestial 25 30

5 275 2
Aa Aa Aa Aa 25 1
mmmsmn mmaemn el | B 275 1

22
23
24
25
26
27

Dividend Frame Mesh  Metropolitan Weekly Total
Aa Aa AO | Aa
o R ...... ......

Parallax  Quotable Savon Vlew

T Browse for Themes...
Fg Save Current Theme...

(6]

(8]

=)

Move the mouse pointer over
the Integral choice in the
Themes gallery. Notice how the
fonts applied on the worksheet
change.

Click the Slice theme.

Double-click the right column
header border for columns C
and E to make them wider to
accommodate the text due to
the theme font change. (Lesson
5 covers this technique in more
detail.)

v Move the mouse pointer over the right
border of the column header you want
to resize until you see the resizing
pointer, which is a vertical bar with left
and right arrows, then double-click to
resize the column.

Drag over the range B2:F2 to
select it.

On the HOME tab in the Font
group, click the Fill Color drop-
down arrow &-. Under Theme
Colors, click the Red, Accent 6,
Lighter 40% fill color in the tenth
column. The selected range
shows a Live Preview of the
color. Click the color to apply it.

Click cell F13.
Click Fill Color drop-down arrow

&y-. Under Standard Colors, click
the Green color.

Save the E04Try_xx file, and
leave it open to use in the next
Try It.

(continued)
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m Choosing a Theme (continved)

Applying a theme color

H - & s E04Try oo - Excel
HOME | INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW
-n-D X CntuyGotic [0 -|& & ==l - = FZ Conditional F
Dact Eg - . I $ - 9% @Tﬂ‘Format as Tal
e o BIU-E-ORA- EEE=EE B ga (7 Cell Styles ~
Clipboard = Font Theme Colors ' Mumber Style:
IT'"HNEEEEEREN
B2 - I
A B I I I ‘i:} D E F
! I I I I I Red, Accent 6, Lighter 40%
2 [AHIGIUBICEREYSE scandard Colors — ]
3 1] EEEEE
4 Member Name l:l Mo Fill Price Number Sold| Total Sales
5 Tamika Brown B — 2.25 17 38.25
6 Tarmika Brown [ % More Colors... 2.5 23 57.5
7 Tamika Brown Mint bars 2.75 27 74.25
Applying Cell Styles m There are also some number format cell styles
available that won't change if you change themes.
m Themes contain a coordinated set of colors, fonts, . . ]
and other elements, such as cell styles. v Sometimes applying a cell style to a cell ho/fl/'ng a /abe/
i ] } causes the label to be cut off rather than spilling over into
m Cell styles in a theme mclgde various styles you the cell to the right as you might expect. If this happens and
can apply to column headings or totals and title and you don’t want to change the column width, also apply the
heading styles. style to the next cell to the right.
m If you apply any of the title, headings, or themed , ) ,
cell styles, the cells using that style will update m If you have a widescreen monitor and display Excel
automatically if you change themes using the full screen, the Cell Styles button will
e change to the Styles gallery.
m You also can apply cell styles that aren’'t changed
m After you select a cell or ranges of cells, you can

if you change themes, such as formats you might
use to highlight good or bad values, a warning, or
a note.

m Applying Cell Styles

use the Cell Styles button or the Styles gallery to
apply a style. Use the gallery scroll arrows to scroll
through the styles. You can also use the More
button to view the styles in one window.

o In the E04Try_xx file, drag over the range B4:F4 O
to select it.

On the HOME tab in the Styles group, click the
Cell Styles button [ to display the gallery of cell
styles.

OR

On the HOME tab, click the More button.

(4]
(5]

In the second column under Themed Cell
Styles, move your mouse pointer over the 60%
- Accent2 choice. The selected range shows a
Live Preview of the cell style. Click the cell style
to apply it.

Drag over the range E13:F13 to select it.

On the HOME tab, in the Styles group, click Cell
Styles [Z7.

(continued)
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m Applying Cell Styles (continved)

@ Under Titles and Headings, click the Total choice @)
in the far right column.

v Notice that the standard color you applied to cell F13
doesn’t change when you apply the cell style.

Double-click the right column header border for
columns B, E, and F to adjust the column widths
due to the new styles.

0

Styles gallery preview

Save the E04Try_xx file, and leave it open to
use in the next Try It.

@ Normal Bad Good Neutral Calculation Gallery scroll
— ) arows
Conditional Format as |[(&[=s Se=] Explanatory ... |Input Linked Cell Note
Formatting = Table -
Styles More button

Styles gallery l

Good, Bad and Neutral

Marmal Bad Good Neutral

Data and Model
Explanatory ... llnput—‘ Linked Cell ’F‘
Warning Text

Titles and Headings

HeadinE 1 Heading2 Heading 3 Heading 4 Title Total

Themed Cell Styles

20% - Accentl  20%- Accent2  20%- Accent3  20%- Accentd  20%- Accent5  20% - Accent6
40% - Accentl  40% - Accent2  40%- Accent3  40%- Accentd  40% - AccentS  40% - Accent6
5% ccent

Mumber Format

Comma Comma [0] Currency Currency [0] Percent

[E Mew Cell Style...

Merge Styles...

Applying Font Formats m If a cell has formatting you applied directly using
the Font group tools, such as bold or underlining,
m The Font group on the HOME tab of the Ribbon that formatting will NOT change if you change
offers choices for formatting text, including font size, themes.
color, and attributes such as bold and italics. m Theme fonts, font colors, and cell colors appear
v This type of formatting is sometimes called direct at the top of the selection list when you click the
formatting. appropriate button. For example, if you click the
Font drop-down arrow, the theme fonts appear at
The Font group settings you apply override the the top of the list.
formatting applied by the current theme. m Standard fill or text colors will not change if you

select a different theme.
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m The way in which your data appears after making
font and font size changes is dependent on your
monitor and printer.

m Applying Font Formats

The available fonts depend on those installed in
Windows.

When you change font size, Excel automatically
adjusts the row height but does not adjust the
column width.

In the E04Try_xx file, click cell B2.
Click HOME > Font drop-down arrow.
Scroll down the list, and click Arial Black.

Click HOME > Font Size drop-down arrow.

0000

Move the mouse pointer over the 24 size, view
the Live Preview, and then click 24.

v When you increase the font size, the row height
increases automatically.

@

Save the E04Try_xx file, and leave it open
to use in the next Try It.

Applying a new font size

3l d ©- &

xm

Bj .
Mouse pointer

EO4Try_sox - Excel

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

ol O
R hume @ RN ==E Y Bwers
B -
Pate . B I u- +§ -A- === &= EMege@Center - § - % * %%
Clipboard 1 Font | 10 n Alignment n Numb [

1 f
12 Art Club Candy Sale

over a size

Toffee bars
Chocolate Almond bars
Mint bars

Tamika E 28
Tarnika E 36
Tamika E 48

Jolee| 72 Toffee bars 47.25
Jolee wn=r Chocolate Almond bars $2.50° 30 $ 75.00
Jolee Chen Mint bars $2.75 24 $ 66.00
John Baker| Chocolate Almond bars $2.50° 12 30.00

John Baker Mint bars

Merging and Centering Across Cells

m You can center a worksheet’s title across the
columns that contain the worksheet data.

B To center a label across several columns, use
the Merge & Center button E merge& center in the
Alignment group of the HOME tab.

v The Merge & Center command actually merges the selected
cells into one large cell and then centers the data in the
newly merged cell.

v You can align merge cells left or right instead of centering
the data. Click the Merge & Center drop-down arrow and
click Merge Across to merge the cells with the current
alignment (left or right).

For Merge & Center to work properly, enter the data
in the first cell in a range, and then select adjacent
cells to the right.

Merged cells act as a single cell. Applying
formatting to a merged cell formats the entire
merged area.

You can unmerge, or separate, merged cells by
selecting the cell and clicking the Merge & Center
bUtton B merge & center AQAIN.
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m Merging and Centering Across Cells

In the E04Try_xx file, drag over the range B2:F2 0
to select it.

On the HOME tab, in the Alignment group, click
the Merge & Center button £ merge & center -

Drag over the range B13:E13 to select it.

0

On the HOME tab, in the Alignment group,
click the Merge & Center button E merge & center -

Leave the merged cell selected. On the HOME
tab in the Styles group, click Total in the gallery
of styles.

Save the E04Try_xx file, and leave it open to
use in the next Try It.

Merge & Center aligns headings over all the data

BH S ¢ EO4Try_ox sy - Microsoft Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
oy ¥ - — =,
[aralBack [0 -[a N = =E ¥ Wrap Text £ E E&
Da [0 -] = »-  Bwep 2
Paste - B I U- - 52 A~ =E= == M:lgea&nlel B 5-9% 12 Wy Conditional Formatas Cell
Formatting~ Table~ Styles-
Clipboard Font ] Alignment E} [ Styles
‘ B2 - | H ‘ 5 H Art Club Candy Sale
A B C D E F G H
1
2] [ AfCubCandySae  —]
=
3 Merged and
4 Price Number Sold Totel Sales
5 Tamika Brown Toffee bars 2.25 17 38.25 Centered Ce”
) Tamika Brown Chocolate Aimond bars 2.5 23 57.5
7 Tamika Brown Mint bars 2.75 27 74.25
8 Jolee Chen Toffee bars 2.25 21 47.25
9 Jolee Chen Chocolate Aimond bars 2.5 30 75
10 Jolee Chen Mint bars 2.75 24 66
11 John Baker Chocolate Aimond bars 2.5 12 30
12 John Baker Mint bars 2.75 18 49.5
13 Weekly Total Yy
14

Applying Number Formats

m  When formatting numerical data, you may want to
change more than just the font and font size—you

may want to also apply a number format.

Number formats are grouped together in the
Number group on the HOME tab.

The number format determines the number of
decimal places and the display of zeros (if any)
before/after the decimal point.

Number formats also include various symbols such
as dollar signs, percentage signs, or negative signs.

Changing the format of a cell does not affect the

actual value stored there or used in calculations—it

affects only the way in which that value is displayed.

There are buttons for quickly applying three

commonly used number formats:

e Accounting format $ 21,008.00, which
includes a decimal point with two decimal
places, the thousands separator (comma), and
a dollar sign aligned to the far left of the cell.

e Percent format 32%, which includes a
percentage sign and no decimal points.

v 32% is entered as .32 in the cell. If you type 32 and
apply the Percent format, you'll see 3200%.

e Comma format 178,495.00, which includes two
decimal places and the thousands separator
(comma).

Using the Number Format list, you can also apply a
variety of other number formats such as Currency,
Long Date, and Fraction.

The Currency format is similar to Accounting
format, except that the dollar sign is placed just to
the left of the data, rather than left-aligned in the cell.

If you don’t see a number format you like, you can
create your own by applying a format that’s close.
For example, you might apply the Accounting
format and then change the number of decimal
places using the Increase Decimal s or Decrease
Decimal *if buttons.

You can also make selections in the Format Cells
dialog box to design a custom number format. Click
the Number group dialog box launcher = to open
the dialog box.
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m Applying Number Formats

In the E04Try_xx file, click cell F5.
On the HOME tab, in the Number group, click

formats the cell with the Accounting format.
Click cell D5.
On the HOME tab, in the Number group,

click the Number Format drop-down arrow
> Currency. Excel formats the cell with the

Currency format. Notice the difference between

it and the Accounting format in cell F5.
Drag over the cell range D6:D12 to select it.

Click the Number Format arrow > Currency.
Drag over the range F6:F13 to select it.
Click the Accounting Number Format $ -.

Drag over the range E5:E12 to select it.

button 31 twice.

In the Number group, click the Decrease
Decimal button %8 twice.

© © 000000

Save and close the file, and exit Excel.

the Accounting Number Format button $ - . Excel

In the Number group, click the Increase Decimal

Applying Currency format

| ABC General [a]
|123 Mo specific format

Number
2.25

Currency

5225 h

Accounting
§2.25

Short Date
1/2/1900

Long Date
Monday, January 02, 1900

Time
6:00:00 AM

Percentage
225.00%

Fraction
21/4

2  Scentific

10 2:E-00

Maore Number Formats...

Lesson 4—Practice

In this project, you will apply font and number formats to cells, merge and center cells, apply cell styles, and apply
a workbook theme using the skills you learned in this lesson.

DIRECTIONS

1. Start Excel, if necessary, and open the
EO4Practice file from the data files for this lesson.

2. Save the file as EO4Practice xx in the location
where your teacher instructs you to store the files
for this lesson.

3. Add a header that has your name at the left, the
date code in the center, and the page number code
at the right, and change back to Normal view.

4. Drag over the row headers for rows 1 through 4 to
select them.

10.

1.

Click HOME > Clear # > Clear Formats.

Click cell A4, type 11/30/14, and press + [ |
On the HOME tab, in the Number group, click

the dialog box launcher to open the Format Cells
dialog box. Date should already be selected in the
Category list.

Click 14-Mar in the Type list, and then click OK.
Click PAGE LAYOUT >Themes [23].

Move the mouse pointer over the Facet theme to
view a Live Preview of its appearance.

Click the lon theme to apply it.



Chapter 1

| Learning Microsoft Excel 2013

12. Drag over the range A1:I1 to select it. 25. Click cell E7, and type the following cell entries,
13. Click HOME > Merge & Center [ werge s Center - pressing [ after each:
14. In the Styles group, click Cell Styles 57, and click a. 2
Title. h. 4
15. Drag over the range A3:13 to select it. c.2
16. Click Merge & Center [ mergea Center - d. 1
17. Click Cell Styles % and then click Heading 2. 26. Drag over the range C7:C29 to select it.
18. Drag over the range A4:14 to select it. 27. Click Accounting Number Format $ -.
19. Click Merge & Center &= merge & center - 28. Press + . Your worksheet should look like
20. Click Bold B. the one shown in Figure 4-1.
21. Drag over the range D5:G5 to select it. 29. With your teacher’s permission, print the
922 Click Merae & Center = worksheet. Submit the printout or the file for
23' Click C "gs les B Me'geice"te" grading as required.
. Click Cell Styles > 20% - Accent 3. ) .
_ y ° _ _ 30. Save and close the file, and exit Excel.
24. Click cell D7, and type the following cell entries,
pressing after each:
a. 1
h. 3
c. 2
d. 2
A | B | € | D | E | F G H [
1 Voyager Travel Adventures
2
3 Logan Store Inventory
4 30-Nov
5 Inventory Valuation
Starting
& ltem # Description Cost Inventory | Additions
7 |BS102 Backpacking stove, dual fue § 25.00 1 2
3 |BS104 Backpacking stove, canister $§ 35.00 3 4
9 BS106 Camping stove, iquid fuel  $ 32.50 2 2
10 BS107 Camping stove, canister $ 100.00 2 1
11 BS108 Camping cooker, canister  $ 40.00
12 |BS110 Stove base $ 10.00
13 |BS111 Stove stand $ 17.50
14 BS112 Heawy duty grill $ 800
15 |BS113 Backpacker grill $ 400
16 |CK101 Open country mess kit $ 450
17 |CK102 Camp cook set $ 50.00
18 |[FL103 Emergency tinder $ 150
19 |[FL104 Fire paste $ 200
20 |FL105 Liquid fuel, 1 gal. $ 3.00
21 [FL108 Canister fuel, 170 g $ 2.00
22 [FL109 Canister fuel. 300 g $ 250
23 (W01 Water carrier, 2L $ 9.00
24 \WJ102 Water carrier, 32 oz $ 450
25 (WJ103 Water carrier, 48 oz. $ 500
26 \WJ104 Dromedary, 6L $ 1500
27 |WJ105 Water bag, 4L $ 10.00
28 (WT101 Water purifier, portable $ 80.00
29 IWT103 Water purifier, camp $ 25.00
30
31
32
33
34

Sheetl

READY
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Lesson 4—Apply

Chapter 1

As the Inventory Manager of the Voyager Travel Adventures retail store, you want to enhance the appearance of an
inventory worksheet you have created. You have already compiled the inventory data, and you want to spruce up

the worksheet prior to printing by adding some formatting.

DIRECTIONS

1. Start Excel, if necessary, and open the E04Apply
file from the data files for this lesson.

2. Save the file as EO4Apply_xx in the location
where your teacher instructs you to store the files
for this lesson.

3. Add a header that has your name at the left, the
date code in the center, and the page number code
at the right, and change back to Normal view.

4. Apply the Organic theme to the file. Notice how
the fonts and colors in the worksheet change.

5. Select the range 17:129 and apply the Percent style.
Then, format the data for two decimal places.

6. Select the range G7:G29 and apply the
Accounting number format.

A B [ € | D @ E |

7. Select the range A6:16 and apply the Accent3 cell
style and Center alignment.

8. Select the range A7:A29 and apply the 60% -
Accent3 cell style.

9. Click cell A4 and apply the *Wednesday, March
14, 2014 date format.

Go to cell A1.Your worksheet should look like the
one shown in Figure 4-2.

With your teacher’s permission, print the
worksheet. Submit the printout or the file for
grading as required.

Save and close the file, and exit Excel.

10.

1.

12.

| G | H | I

Voyager Travel Adventures

Logan Store Inventory
Sunday, November 30, 2014

L I

Starting

Additions

Dezcription

gl B5102 Backpacking stove, dual fuel 1 2
Ll BES104 Backpacking stove, canister 1 3 4
bl B5106 Camping stove, liquid fuel § 3250 2 2
10 By Camping stove, canister § 100,00 2 1
A BS103 Camping cooker, canister § 60000 2 0
(¥4 BS110 Stove base § 1000 1 1
13 pngl § 1730 2 1
LY B3112 § 800 2 0
|8 BES113 g 400 5 4
iy CE101 Open country mess kit § 630 4 3
17 Camp cook set § 5000 2 1
JLY FL103 § 130 9 7|
|RJ F1.104 § 200 12 6
P FL105 g 300 18 15
Al FL102 Canister fuel 170 g § 200 20 5
poq F1.109 Canister fuel, 300 g § 250 21 13
pay w101 Water carner, 2L § 900 10 2
24 gyl Water carrier, 32 oz § 430 12 6
ey 103 Water carner, 48 oz. § 500 3 15
g 104 Dromedary, 6L § 1500 6 6
27 Water bag, 4L § 1000 10 2
pry W01 Water punfier, portable § 3000 13 3
PR 103 Wates pusifier, camp § 2500 12 0

30

Inventory Valuation
Ending

Inventory

Full Stock

Current Stock

Value Level Percentage
3§ 7500 4 75.00%
7% 245.00 8 87.50%
4 § 130,00 5 80.00%
3§ 300.00 3 60.00%
2§ 12000 2 100.00%
2§ 2000 3 66.67%
3§ 5250 3 100.00%
2§ 1600 3 66.67%
9§ 36.00 10 90.00%
78 4550 10 70.00%
3§ 15000 4 75.00%
16/ § 2400 15 106.67%
18/ §  36.00 24 75.00%
338 99.00 36 91.67%
25/ 8 5000 36 69.44%
34/ 8 8500 36 94 44%
12 § 108.00 15 80.00%
18/ § 81.00 24 75.00%
18/ § 90.00 24 75.00%
12/ § 180.00 15 80.00%
12/ § 12000 15 80.00%
20| §1,600.00 20 100.00%
12/ § 300.00 12 100.00%
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Lesson 5

More on Cell Entries
and Formatting

> What You Will Learn

Entering Dates

Filling a Series

Aligning Data in a Cell

Wrapping Text in Cells

Changing Column Width and Row Height
Using Keyboard Shortcuts

WORDS TO KNOW Software Skills Use dates to identify when you created a worksheet or to label

Auto Fill a column or row of data by time period. After typing dates, labels, and numbers in

The feature that enables a worksheet, you can improve its appearance by changing the alignment of data

Excel to create a series and the widths of columns. If you need to enter a series of labels (such as Monday,

automatically. Tuesday, Wednesday) or values (such as 1, 2, 3), using Excel’s Auto Fill feature
saves data entry time and reduces errors.

Date

A cell entry that indicates

a date or time and is

stored as a date code in What You Can Do

Excel.

Entering Dates
Default column width 9

The default number of m Enter a date when you need to indicate the timing for data. Excel stores dates as
characters that display in special date codes, but automatically applies a Date number format depending
a column based on the on how you type in the date.
default font. ®m You can enter a date usin f these date f ts:
g one of these date formats:
Fill handle e mm/dd/yy, as in 1/14/14 or 01/14/14
A black box on the mm/dd, as in 1/14

lower-right corner of the
selected cell or range that
you can use to fill (copy)
a series or formula.

[ ]
e dd-mmme-yy, as in 14-dan-14
e dd-mmm, as in 14-Jan

v The current year is assumed for any date entry that doesn’t include a year.

&:))/,b-g::j shortouts m To enter today’s date quickly, press + [i] and then press .
for choosing Ribbon m To enter the current time, press + + [i] and then press :

commands that you
display by pressing Alt.
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m After entering a date, you can change its number format as needed. For
example, you can change the date 1/14/14 to display as January 14, 2014.

m To enter a time, follow a number with a or p to indicate AM or PM, like this:
10:43 p.
® You can enter a date and time in the same cell, like this: 10/16/14 2:31 p.

m Entering Dates

Start Excel.

Open the E05Try file from the
data files for this lesson.

Save the file as E05Try_xx in
the location where your teacher
instructs you to store the files for
this lesson.

(7]
(8]

Add a header that has your name o

at the left, the date code in the
center, and the page number
code at the right, and change
back to Normal view.

Click cell C3 to select it.

Press + [, and then press
to insert the current date.
It appears in the mm/dd/yyyy
format.

Click cell C3 to select it again.

Click HOME > Number Format
drop-down arrow > General. The
date code for the date appears in
the cell. The date code that you
see will vary depending on the
date you entered.

Click HOME > Number Format
drop-down arrow > Short Date.

Save the E05Try_xx file, and
leave it open to use in the next
Try It.

A date code
ﬂﬂ E - 2 = EO5Try_xxxlsx - Microsoft Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
a - - fp—
O EJ"E’ | Calibri i cA s E=E2®- B |Genenl -
':Ia -
Paste B I U - DA EE=EE H O$ 0%
v - 4 - General number
Clipboard & Font o Alignment & ny format
‘::3 - ‘ : ‘ e H 41191
A B [ D E F G H

Next Door Grocers

Goods Received by Pallet

Report Date:

| 41191_|—| Date code I

Y TS SR | N NS D N RO NP N Y DU S SRS S

Keyboard shortcuts
Specific keyboard keys
that you press together or
in sequence to execute
commands or apply
settings.

Series

A list of sequential
numbers, dates, times,
or text.

Wrap text

A feature that causes
long cell entries to
appear on multiple lines.
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Filling a Series =

m A series is a sequence of numbers (such as 1, 2,
3), dates (such as 10/21/14, 10/22/14, 10/23/14),
times (such as 2:30, 2:45, 3:00), or text (such as -
January, February, March). The feature or process
for creating a series in Excel is called Auto Fill.

m To enter a series based on the active cell, drag the
fill handle, a small square in the lower-right corner -
of the active cell that turns into a plus sign (+), over
the range of cells you want to fill with the series.

m Excel can create some series automatically. For
example, type January in a cell, and then drag the
fill handle down or to the right to create the series
January, February, March, and so on.

A yellow ScreenTip appears under the mouse
pointer, displaying the cell values of the series as
you drag. The series values appear in the cells after
you release the mouse button.

To create an incremental series (i.e., 1, 3, 5, 7),
enter the data for the first and second cells of a
series, select the two cells, and then drag the fill
handle over the range of cells to fill.

You can also use the fill handle to copy formatting
only (such as bold, italics, and so on) from one cell
to adjacent cells, and not its value, or the value
only without formatting. To do so, click the Auto Fill
Options button that appears when you perform the
fill, and then click Fill Formatting Only or Fill Without
Formatting.

In the EO5Try_xx file, click cell B6 to select it.

Type 4/2 and press . This enters the date
with the format 2-Apr.

Type 4/9 and press . This is the second date
in the sequence that you're entering.

Drag over the range B6:B7 to select it.

Drag the fill handle down until the ScreenTip
reads 30-Apr, and then release the mouse
button.

v When you enter dates with the abbreviated format used
in steps 2 and 3, Excel applies the year specified by your
current system date, so your results may vary from those
shown in this chapter.

@ Click cell C6 to select it.
@ Type 1 and press [cnl + [ (1))
9 Drag the fill handle right through cell G6, and

then release the mouse button. @

v Notice that a single number just repeats and doesn’t
automatically increment.

Click cell C7 to select it. @
Type 2 and press [z .

Drag over the range C6:C7 to select it.

=X=) )

Filling a series

‘ BG - | H ‘ A H 4/2/2012
A | B | C D E

1 [Next Door Grocers

2 |Goods Received by Pallet

3 |Report Date: 41191

4

3 Shipment Dry Goods Bulk Prodi Packaged

6 | 2-Apr

7 9-A ‘

| = } Fill handle |
8
g ooy |
ScreenTip
10 o A AT
11

Drag the fill handle down until the ScreenTip
reads 5, and then release the mouse button.

With the range still selected, drag the fill handle
right through column G. This fills the values
across the columns, replacing the 1s already in
row 6.

Save the E05Try_xx file, and leave it open to
use in the next Try It.
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When you have a series of labels in one column
that you want to format, the Flash Fill feature in
Excel can recognize the pattern in the text and
change the format of the text for the series.

Flash Fill can change the case of names that
have been typed in lowercase to uppercase or
change the format of phone numbers to include
parentheses for the area code.

Flash Fill only works when your text is in a single
column.

In the first cell next to the column you want to
change, type the text the way you want it and press
=] . Flash Fill begins to learn the pattern in the
text.

Next, type text into the second cell.

v If you select another cell or click on the Ribbon before typing
in the second cell, the Flash Fill feature will not be available.

When you type in the second cell, Flash Fill shows
a preview of suggested changes for the rest of the
series. Press to accept the suggestions.

v To continue typing without using Flash Fill suggestions,
press the key .

® ©0 ®© 0o

Chapter 1

You can use the Flash Fill Options button to
accept or undo the suggestions.

v If the Quick Analysis Lens displays, press the key. You
will learn about the Quick Analysis Lens in Chapter 2.

Flash Fill also can separate labels (such as names
or addresses) into different columns or combine
labels from several columns into one.

When you want to separate first and last names
that are in one column, use Flash Fill to create two
new columns with first names in one column and
last names in another column.

When you want to combine first names, middle
initials, and last names that are in three columns,
use Flash Fill to create a new column with the
complete name.

Flash Fill is case sensitive and works best with
consistent labels. For example, all of the last names
in a series need to be lowercase for Flash Fill to
change the names to be uppercase.

v If the labels are not consistent, Flash Fill may not always
separate the data elements correctly.

In the EO5Try_xx file, click cell 16 and type the
following cell entries, pressing after each:
a. Michael W. Penn

b. Rosie L. Patton

¢. Jameson P. Falcon

d. Jon D. Stalwart

e. Mia A. Dawson

Click cell J6 to select it, type Penn, Michael W.,
and press [ .

In cell J7, type Pa. The Flash Fill preview
suggestions appear.

Press to fill cells J7:J10 with the series of
last names, a comma, first names, and middle
initials.

Click the Flash Fill Options button £ > Undo

Flash Fill.

® 60 ©00 606 000

Click the Undo button € twice.
In cell J6, type Michael, and press [ .

In cell J7, type Ro, and press [==] . Flash Fill fills
the series of last names in cells J7:J10.

In cell K6, type W., and press = .

Click cell L6 to select it, type Penn, and press
.

In cell L7, type Pa.

Click the Flash Fill Options button > Accept
Suggestions.

Drag over the range J6:L10 to select it.

On the HOME tab, in the Editing group, click
Clear # Clear- > Clear All.

Save the E05Try_xx file, and leave it open to
use in the next Try It.
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Aligning Data in a Cell

When you type a label, Excel automatically aligns it
to the left of the cell. Excel aligns values and dates
to the right by default.

In addition, cell entries are aligned along the
bottom edge of the cell.

To improve the appearance of a worksheet, you
can change the alignment (both vertically and
horizontally) of column labels, row labels, and other
data.

m Aligning Data in a Cell

@Oe00® © ©

| Learning Microsoft Excel 2013

To align data, select the cells to format and use the
buttons in the Alignment group on the HOME tab.

Align data between the top and bottom sides of

a cell using the Top Align =, Middle Align =, or
Bottom Align = buttons.

Align data between the left and right sides of a cell
using the Align Left =, Center =, or Align Right
buttons =.

v Use the Decrease Indent €= and Increase Indent 3=
buttons to add or remove space at the left end of the cell
for left-aligned entries.

In the EO5Try_xx file, drag over the range
B6:B10 to select it.

On the HOME tab, click the Align Text Left
button =.

Drag over the range C6:G10 to select it.

On the HOME tab, click the Center button =.
Drag over the range A1:11 to select it.

On the HOME tab, click Merge & Center

Merge & Center ,

@

o

[10)

On the HOME tab, click Cell Styles 2% >
Accent5.

v If you are working on a widescreen monitor, the Cell
Styles button will change to the Styles gallery.

On the HOME tab, click Increase Font Size A
five times.

On the HOME tab, click Middle Align

v You will only see a subtle vertical alignment change in
cell A1 at this point.

Save the E05Try_xx file, and leave it open to
use in the next Try It.

Center aligned cells

BHS & -

E05Try_socxlsx - Microsoft Ex

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW

-y e v | = .

B db Calibri n KN =E=E% E @
pase 2 " $-% »

aste B I U~ i« - r === & = -

e U-|H A- SE=EE B g
Clipboard Font ] Alignment F] Mumber I
o ]

1l
“ﬁi Alignment choices l
| |

A B C D E E G H
; Next Door Grocers
2 |Goods Received by Pallet
3 |Report Date: 41191
4
5 Shipment|Dry Goods Bulk Prodi Packaged Paper Pro Cleaning Products
6_ 2-Apr 1 1 1 1 1
T_ S-Apr 2 2 2 2 2
8_ 16-Apr 8 3 g 3 3
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Wrapping Text in Cells

m When a cell with a long label entry is too wide to
display, you can use the wrap text feature to wrap

the text to multiple lines.

The Wrap Text button =¢ is in the Alignment group
on the HOME tab of the Ribbon. Click it to apply
and remove wrapping in the selected cell or range.

m Wrapping Text in Cells

Wrapping sometimes causes a line of text to break
within a word, so you may need to adjust the
column width for some columns after applying the
wrapping.

o In the EO5Try_xx file, click cell A2

: (3)
to select it.
(2]

On the HOME tab, click the Wrap Text button &°. e
v You will correct the column widths soon.

Drag over the range B5:15 to select it.
On the HOME tab, click Wrap Text =.

Save the E05Try_xx file, and leave it open
to use in the next Try It.

Changing Column Width and Row Height

m In a workbook file using the default Office theme,
the default column width is 8.43 characters in the
Calibri, 11 point font. The default column width
varies in characters depending on the theme

applied.

You can quickly adjust a column to fit the longest
entry in that column by double-clicking the right
border of the column header, as you've seen in
earlier lessons. Drag the right border to resize the
width manually.

The default row height in a workbook using the
Office theme is 15 points.

In some cases, such as when you apply a new
number format, the column width increases
automatically.

In some cases, such as when you increase the
font size of text or wrap text in a cell, the row height
increases automatically.

Double-click the bottom border of the row header
to fit the row size automatically. Drag the border to
resize it manually.

Drag over multiple column or row headers or over
cells in multiple columns or rows to resize all the
selected rows or columns at once.

Clicking the Format button & in the Cells group
on the HOME tab opens a menu with commands
for automatically sizing (AutoFit Row Height and
AutoFit Column Width) or manually sizing (Row
Height and Column Width) rows and columns.

m Changing Column Width and Row Height

In the EO5Try_xx file, move the mouse pointer
over the right border of the column A column
header until you see the resizing pointer, which
is a vertical bar with left and right arrows.

Drag right until the ScreenTip shows a width
of 10.00, and then release the mouse button
to finish resizing the column.

Drag over the range B5:G5 to select it.

On the HOME tab, click Format = Column
Width.

Changing column width by dragging

| B5 [ Width: 10.00 (97 pixels) Ehipme

A B C

Goods

L
2 Pallet
3 Report Date; 5/12/2013
4

(continued)
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m Changing Column Width and Row Height (continved)

9 Type 9.57 in the Column width text box of the 0 Drag down until the ScreenTip shows a height
Column Width dialog box, and then click OK. of 42.00, and then release the mouse button to
finish resizing the row.

@ Move the mouse pointer over the bottom border

of the row 1 row header until you see the 6 Save the E05Try_xx file, and leave it open to
resizing pointer. use in the next Try It.
Ilsing Keybourd Shortcuts m Pressing the key displays Key Tips, which are
keys you can press to select commands on the
® You can use keyboard shortcuts—combinations Ribbon.
of two or more keys pressed together or i_n m After pressing [l , press the Key Tip for the
sequence—to perform many commands in Excel. desired Ribbon tab, and then the Key Tip for the
v Many keyboard shortcuts are the same as they’ve been in command.
/g evious versions of Excel, such as (<] + [o] to display the v The Help topic “Keyboard shortcuts in Excel 2013” explains
pen pane.

Key Tips in detail and lists all the available keyboard

m Several of the formatting choices have keyboard shortcuts.
shortcuts, such as + [8] for applying bold. Move
the mouse pointer over a Ribbon button, and the
ScreenTip lists a keyboard shortcut if one exists.

m Using Keyboard Shortcuts

In the EO5Try_xx file, click cell C3 to select it.

You learned earlier about keyboard techniques for
navigating and making selections, such as using
the arrow keys to move from cell to cell.

Press [ three times and [€] once to select cell
B6.

Press and hold and press [4 four times to
select the range B6:B10.

Press . The tab Key Tips appear onscreen.
Press [F]. The Page Layout tab appears.

Press twice to redisplay the tab Key Tips.
Press [H]. The HOME tab appears.

Press [1]. The Cell Styles gallery opens.

Press + [8] to apply bold to the selection.
Press + [ to apply italics to the selection.
Press + [s] to save the file.

Press + [£] to display the the Backstage
view.

Press [ four times to select the 20%-Accent1
style, and then press .

© 066 © O

Press [c] to exit Excel.
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Lesson S5—Practice
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In this project, you will align data in cells, wrap text in cells, change column width and height, fill a series of cells
with data, and use keyboard shortcuts.

DIRECTIONS

1.

10.
11.
12.

13.
14.

15.
16.
17.
18.
19.
20.

Start Excel, if necessary, and open the
E05Practice file from the data files for this lesson.

Save the file as EO5Practice_xx in the location
where your teacher instructs you to store the files
for this lesson.

. Add a header that has your name at the left, the

date code in the center, and the page number code
at the right, and change back to Normal view.

Click cell J3, type 7/6/14, and press .
Click cell D6, type Jan, and press + .

Drag the fill handle right through cell 16 to
automatically fill with the series of month labels.

Drag over the range D7:17 to select it.

Drag the fill handle down through cell 114. This
fills all the selected cells with the values from the
selection.

Click cell D14, type 25, and press [T&l.
Type 50, and press [18].
Drag over the range D14:E14 to select it.

Drag the fill handle right through cell 114. Excel
fills the cells with a series that increments based
on the first two entries.

Drag over the range C6:J6 to select it.

Press + [H] to select the HOME tab and display
its Key Tips.

Press [+ [R] to align the labels to the right.
Click cell C3 to select it.

In the HOME tab, click Wrap Text &¢.

Click cell C7 to select it.

Type Clark, Joe and press .

In cell C8, type Hi and press . Flash Fill fills the
range C8:C14 with the series.

21.
22.

23.

24.

25.
26.

27.
28.
29.
30.
31.

32.
33.
. Type 52 in the Row height text box in the Row

35.

36.

37.

Drag over the range A7:B14 to select it.

On the HOME tab, click Clear # > Clear
Contents.

Drag over the column headers for columns A and
B to select them.

Move the mouse over the column B header right
border until you see the resizing pointer, and drag
left until the ScreenTip displays a width of 1.00.

Release the mouse button to resize the columns.

Click the column J header.
Double-click the column J header right border.
This automatically AutoFits the selected column.

Drag over the column headers for columns D
through | to select them.

On the HOME tab, click Format E > Column
Width.

Type 8.43 in the Column width text box in the
Column Width dialog box, and then click OK.
Double-click the column C header right border to
AutoFit the column.

Double-click the row 3 and row 6 header bottom
borders to AutoFit the rows.

Click cell C1 to select it.

On the HOME tab, click Format & > Row Height.

Height dialog box, and then click OK.

On the HOME tab, click Middle Align =. Press
+ [s] to save the file. Your worksheet should
look like the one shown in Figure 5-1 on the next
page.

With your teacher’s permission, print the
worksheet. Submit the printout or the file for
grading as required.

Press [A0] + [F] and then [c] to close the file.
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Serenity Health Club

Client Account

3 Tracking 7/6/2014
4

5 Payments by Month

6 Client Name Jan Feb Mar Apr May Jun Total
7| Clark, Joe $150 $150 $150 $150 $150 $150 $900
g Higgins, Mary $150 $150 $150 $150 $150 $150 $900
5 | Stevens, Gary $150 $150 $150 $150 $150 $150 $900
10| Roberts, Paul $150 $150 $150 $150 $150 $150 $900
1 Moyer, Anne $150 $150 $150 $150 $150 $150 $900
12| Santos, Antonio $150 $150 $150 $150 $150 $150 $900
12| Jones, Brett $150 $150 $150 $150 $150 $150 $900
14 Stewart, Dorothy $25 $50 $75 %100 $125 $150 $525
15

16 Totals $1,075 $1,100 $1,125 $1,150 $1,175 $1,200  $6,825
17

Lesson S—Apply

You are the Accounts Receivable Supervisor at the Serenity Health Club. You need to compile data on client
payments and extra services sold in a worksheet and improve its formatting.

DIRECTIONS

1.

© PN

10.

Start Excel, if necessary, and open the 05Apply
file from the data files for this lesson.

Save the file as EO5Apply_xx in the location
where your teacher instructs you to store the files
for this lesson.

Add a header that has your name at the left, the
date code in the center, and the page number code
at the right, and change back to Normal view.

Click cell A3, type 7-6-14, and press [ .
Click cell G3 to select it.

Wrap the text and align the text right.
Click cell A1 and top align the data.
Adjust the height of row 1 using AutoFit.

Click cell C6 and fill to cell G6 to fill with a series
of label entries.

Click cell A8. Drag the fill handle down to A11 to
fill four week labels.

11

12.

13.
14.
15.

16.

17.
18.

19.
20.
21.

22.

. Select the range C8:C9.

Drag the fill handle down to cell C11 to fill with a
series of increasing values.

Click cell B8, type Week 1, and press [ .
In cell B9, type Week 2.

Drag the fill handle down to cell B11 to fill the
series of capitalized labels.

Select the range A8:A11 and clear the contents of
the cells.

Select the range D8:D9.

Drag the fill handle down to cell D11 to fill a series
of decreasing values.

Select the range A5:G6.
Wrap the text in the selection.

With the range still selected, apply bold to the
entries.

With the range still selected, change the column
width to 13.5.
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23. With the range still selected, apply Center 26. Go to cell A1.Your worksheet should look like the
alignment. one in Figure 5-2.

24. Resize row 7 to a height of 6.00. A thin filled row 27. With your teacher’s permission, print the
or column like this is another method for creating a worksheet. Submit the printout or the file for
border. grading as required.

25. Select the range C11:G11 and apply the Underline 28. Save and close the file, and exit Excel.
style.

Serenity Health Club

Extra Services

7/6/2014 Sold

Swedish Aromatherapy  HotStone  Exfoliating Salt Aromatherapy
Service Name Massage Massage Massage Scrub Facial
Service Code Serv001 Serv002 Serv003 Serv004 Serv005
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Lesson 6

Working with Ranges

WORDS TO KNOW

Contiguous range
A block of adjacent cells
in a worksheet.

Noncontiguous range
Cells in a worksheet that
act as a block, but are not
necessarily adjacent to
each other.

Collapse Dialog box
button

A button in a dialog box
that you click to downsize
a dialog box to make a
selection on the sheet,
and then click again to
restore the dialog box to
its regular size.

Range
A block of cells in an
Excel worksheet.

> What You Will Learn

Selecting Ranges
Entering Data by Range
Making a Range Entry Using a Collapse Dialog Box Button

Software Skills Select a group of cells (a range) to copy, move, or erase the
data in them in one step, or to quickly apply the same formatting throughout the
range. You also can fill a range of cells with an entry, or perform calculations on cell
ranges—creating sums and averages, for example. Some dialog boxes include a
Collapse Dialog box button that enables you to specify a range entry in a text box.

What You Can Do

A range is an area made up of two or more cells.

When you select cells A1, A2, and A3, for example, the range is indicated
as A1:AS.

The range A1:C5 is defined as a block of cells that includes all the cells in
columns A through C in rows 1 through 5.

A range of cells can be contiguous (all cells are adjacent to each other or in a
solid block) or noncontiguous (not all cells are adjacent to each other).

To select a contiguous range, drag over it. You also can click the first cell, press
and hold , and use the arrow keys to extend the selection or click the cell
that’s at the lower-right corner of the range to select.

To select a noncontiguous range, select the first portion of the range.
Then press and hold the key while dragging over additional areas or
clicking additional cells. Release the key when finished selecting all the
noncontiguous areas.

When a range is selected, the active cell is displayed normally (with a white
background), but the rest of the cells appear highlighted.

v You also can assign a name to a range and use it to select or refer to the range. See “Using
Named Ranges” in Lesson 13.

Clicking the column or row header selects the entire row or column. You also
can press + to select the column holding the active cell or + to
select the row holding the active cell.
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m Selecting Ranges

Start Excel.

On the HOME tab, click Cell Styles Z#, and

Open the E06Try file from the data files for this L E] e
lesson. Drag over the range D4:E4 to select it. Press

and hold the key, and click cell B3.

On the HOME tab, click Cell Styles Z#, and
then click Accent6.

Save the file as E06Try_xx in the location where
your teacher instructs you to store the files for
this lesson.

Click the column C column header to select
the column.

On the HOME tab, click Cell Styles 2%, and
then click Accent6.

© © o0

Add a header that has your name at the left, the
date code in the center, and the page number
code at the right, and change back to Normal
view.

With cell A1 selected, press and hold the
key while pressing [2] four times.

On the HOME tab, click Merge & Center

Merge & Center ,

Drag over the range B5:B10 to select it.
On the HOME tab, click Wrap Text =.

Move the mouse pointer over the right border of
the column B column header and drag right until
the ScreenTip shows a width of 20.00.

On the HOME tab, click Format = > AutoFit

© @

Drag over the range A5:A10 to select it.

A noncontiguous range selection

® 0 6 660 ©@ © 6 © O

Row Height.
B3 M £ || ClientID: Move the mouse pointer over the right border of
" Address of upper-left D E the column C column header and drag left until
1 selected cell the ScreenTip shows a width of 1.00.
: - Save the E06Try_xx file, and leave it open
3 Ictient 1D:] —— Selection to use in the next Try It.
4 Yes |No
5 Was the room comfortable?
6 Were the staff members cordial?
7 Did vour appointment start on time?

Entering Data by Range m The Fill button [#] in the Editing group on the HOME
tab offers choices that enable you to fill cells in the
m Inthe last lesson, you learned how to enter data desired direction in a selected range and to create
by using the fill handle. There are a couple of other custom series. For example, you can click Down to
methods you can use to fill a range. fill down the column, or Right to fill across the row.
m To fill all the cells in a selected range with the same Click Series to create a series to fill.

entry, first select the range. Then type the desired
entry, and press + o]
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m Entering Data by Range

In the E06Try_xx file, drag over the range
A5:A10 to select it.

Type 1 and press [ .
On the HOME tab, click Fill [#] > Series.

In the Series dialog box, make sure the
Columns and Linear options are selected and
that 1 appears in the Step value text box, and
then click OK.

Client 1D:

TN R

Was the room
5 comfortable?
Were the staff
members cordial?

Did your appointment
start on time?

First entry in
selected range

Were your treatments
8 explained?

Were you relaxed
during the process?
Were you offered a
10 _beverage?

Drag over the range D5:D6 to select it.

Press and hold [c=] , and click cells E7, D8, D9,
and E10.

v/ Be sure to release the key when you finish.

Type X, and press + [ . Excel fills all the
selected cells with the entry.

@0

(8]

Filling a range

Save the changes to E06Try_xx, and leave it
open to use in the next Try It.

Series in Type Date unit

O Bows @ Linear ® Day

@ LColumns O Growth Weekday
() Date Maonth

() sutoFill Year

[]1rend

Step value: EI Stop value: I:I

| oK

Making a Range Entry Using a Collapse
Dialog Box Button

You will most likely set options in Excel using the
buttons on the Ribbon, however, occasionally, you
may use a dialog box.

Dialog boxes appear when you click the dialog box
launcher ™ within a particular group on the Ribbon.

m To enter cell addresses or ranges in a dialog box,
you can click the Collapse Dialog box button on
the right end of the text box to shrink the dialog box
S0 you can see the worksheet and select the range,
rather than type it.

m After selecting the range, click the Collapse Dialog
button to restore the dialog box to its normal size,
and then finalize your selections.
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m Making a Range Entry Using a Collapse Dialog Box Button

0®® © 0 ©

In the E06Try_xx file, on the PAGE LAYOUT tab,

in the Page Setup group, click the dialog box
launcher .

Click the Sheet tab.

Click the Collapse Dialog box button "# at the
right end of the Print area text box.

Drag over the range A1:E10 to select it and
enter it in the text box.

Click the Collapse Dialog box button "# again.
Click OK.

Save and close the file, and exit Excel.

Using the Collapse button

Client ID:

Selected range

\Was the room
comfortable?
Were the staff
gl members cordial?
Did your appointment
Ellstart on time?

(Were your treatments
Bllexplained?

\Were you relaxed
Ellduring the process?
\Were you offered 2

x

Collapse Dialog box button

Lesson 6—Practice

In this project, you will select a range of cells and fill a series using the skills you learned in this lesson.

DIRECTIONS

1.

e N o

10.

Start Excel, if necessary, and open the
EO6Practice file from the data files for this lesson.

Save the file as EO6Practice_xx in the location
where your teacher instructs you to store the files
for this lesson.

Add a header that has your name at the left, the
date code in the center, and the page number code
at the right, and change back to Normal view.

Click cell B25, type Frieda, and press [18].
Type Randall, and press [ .

Click cell B26, type John, and press [T8].
Type Henson, and press .

Drag over the range A1:E1 to select it, and on the
HOME tab, click Merge & Center E Merge& Center ,

Drag over the range A2:E2 to select it, and on the
HOME tab, click Merge & Center EMergea Center ,

Drag over the range A4:E5 to select it, and on the
HOME tab, click Cell Styles [Z# > Accent2.

1.

12.

13.
14.
15.
16.
17.

18.
19.

20.
21.
22.

Drag over the range A9:E9 to select it, and click
HOME > Cell Styles &? > Accent2.

Drag over the range A5:ES5 to select it, and on the
HOME tab, click Wrap Text ¢ > Center =.

Click cell A6 to select it.

Type 1, and press .

Drag over the range A6:E6 to select it.
On the HOME tab, click Fill [¥] > Series.

Make sure that the Rows and Linear options are
selected and that 1 is entered as the Step value,
and click OK.

Drag over the range D11:D12 to select it.

Press and hold , and click cells D15, D18,
D21, D22, and D26. Be sure to release after
clicking the last cell.

Type 3, and press 4[] |
Click cell D19 to select it.
Type 4, and press 4[] |
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23. Select the range D19:D20 to select it. 28. Press + . Your worksheet should look like

24. On the HOME tab, click Fill [ > Down. the one in Figure 6-1.

25. Drag over the column headings for columns A 29. With your teacher’s permission, print the
through E. worksheet. Submit the printout or the file for

26. Right-click the selected column headings, and click grading as required.
Column Width. 30. Save and close the file, and exit Excel.

27. Type 13 in the Column width text box, and click
OK.

1 Overview Academy
2 Instructor Performance Ratings
Scale: 1-5
Meeds Exceeds
Unacceptable Improvement Acceptable  Expectations Outstanding
First Name Last Name 2013 Rating 2014 Rating
10 |Band Angela Green
11 |Business Markus Wright 3
12 |Calculus Vincent Gambel 3
13 |Chemistry Linda Brown
14 |Computer Basit Robert Cardo
15 |Computer Grap Phyllis Weaver 3
16 |Computer Prog Ramon Ramirez
17 |English Terry Kaminsky
18 |Fine Arts Stella Andrews 3
19 |French Francoise Martine 4
20 |Geometry Allen Chang 4
21 |Health/Phys Ed Axel Jones 3
22 |History Fred Wilson 3
23 |Life Manageme Stewart Bing
24 |Science Carl Tyrell
25 |Social Studies  Frieda Randall
26 |Spanish John Henson 3
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You are the Principal of Overview Academy, a small private school. You want to create a worksheet to track
instructor performance ratings from two prior years. You need to finish entering some of the worksheet data,
including the ratings, apply some formatting, and specify the range to print.

DIRECTIONS

1.

Start Excel, if necessary, and open the EO6Apply
file from the data files for this lesson.

Save the file as EO6Apply_xx in the location
where your teacher instructs you to store the files
for this lesson.

. Add a header that has your name at the left, the

date code in the center, and the page number code
at the right, and change back to Normal view.

Adjust the width of column A using AutoFit.
Drag over the range A8:ES8 to select it.

Open the Format Cells dialog box, and click the
Alignment tab, if necessary.

Open the Horizontal drop-down list and click Fill.
Then click OK. This fills the selected range with
the symbol character in cell A8, another way of
creating a border.

Select the following non-contiguous cells: D10,
E10, E17, E18, E22, E23, and E25.

. Type 4, and press [ca] + [a] .
10.
11.
12.

Click cell E11 to select it.
Type 5, and press + [
Fill the range E12:E14 with the same value.

13.

14.

15.

16.

17.

Enter the following data in the blank cells in
column D:
.5

(SIS ) I \C I \C I |

.2
Enter the following data in the blank cells in

column E:
.3

a
b
C.
d.
e
f
g

a
b
C.
d
e
f

(7% I - NS IS ) I

g.- 2

Open the Page Setup dialog box, and on the
Sheet tab, set the Print area to A1:E26. Your
worksheet should look like the one in Figure 6-2 on
the next page.

With your teacher’s permission, print the
worksheet. Submit the printout or the file for
grading as required.

Save and close the file, and exit Excel.
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A B C D E
1 Overview Academy
2 Instructor Performance Ratings
Scale: 1-5
MNeeds Exceeds
5 Unacceptable Improvement Acceptable  Expectations Outstanding
6
7
Er T T I T T R T TR T I Y Y R R Y YT Y IR T T YT TRY YT TYYT Y]
g First Mame Last Name 2013 Rating 2014 Rating
10 |Band Angela Green 4 4
11 |Business Markus Wright 3 5
12 |Calculus Vincent Gambel 3 5
13 |Chemistry Linda Brown 5 5
14 |Computer Basics Robert Cardo 5 5
15 |Computer Graphics Phyllis Weaver 3 3
16 |Computer Programming Ramon Ramirez 2 3
17 |English Terry Kaminsky 2 4
18 |Fine Arts Stella Andrews 3 4
19 |French Francoise Martine a4 5
20 |Geometry Allen Chang 4 5
21 |Health/Phys Ed. Axel Jones 3 4
22 |History Fred Wilson 3 4
23 |Life Management Stewart Bing 5 4
24 |Science Carl Tyrell 5 3
25 |Social Studies Frieda Randall 2 4
26 |Spanish John Henson 3 2
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Lesson 7

Creating Formulas

> What You Will Learn

Entering a Formula

Using Arithmetic Operators

Editing a Formula

Copying a Formula Using the Fill Handle
Using the SUM Function

Software Skills Creating formulas to perform calculations in Excel provides one
of its powerful benefits: automatic recalculation. When you make a change to a cell
that is referenced in a formula, Excel automatically recalculates the formula to reflect
the change and displays the new formula result.

What You Can Do

A formula is a worksheet instruction that performs a calculation.
Enter a formula in the cell where the result should display.
As you type a formula, it displays in the cell and in the formula bar.

If you enter a long formula in a cell, that text may not fully display in the formula
bar. You can expand the formula bar (make it taller) by clicking the Expand
Formula Bar button ~| at the right end of the formula bar.

When you select a cell that has a formula, the answer displays in the cell while
the formula appears in the formula bar when the cell is selected.

Use cell or range references, values, and mathematical operators in formulas.

v A formula can also contain Excel’s predefined functions, which are covered in Lesson 11, or use
named ranges, which are covered in Lesson 13.

You must start each formula by typing the equal sign (=). For example, the
formula =B2+B4+B6 adds together the values in those three cell locations.

When you change the value in a cell that is referenced in a formula, the answer
in the formula cell automatically changes.

When typing a percentage as a value in a formula, you can enter it with the
percent symbol or as a decimal.

You can click a cell or drag a range to enter its address in the formula. This
method can be more accurate than typing cell or range addresses.

WORDS TO KNOW

Arithmetic
(mathematical)
operators

Symbols used in
mathematical operations:
+ for addition, - for
subtraction, * for
multiplication, / for
division, and A for
exponentiation.

Formula
An instruction Excel uses
to calculate a result.

Order of precedence
The order in which

Excel performs the
mathematical operations
specified in a formula,
based on the types of
mathematical operators
used.

SUM function

A built-in calculation used
to add a range of values
together.
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0 Start Excel. Entering a formula
0 Open the E07Try file from the data files for this ) =
lesson. |SUM . | : | vk ” =ssrc| — Formula in
. . . A B C D E | formula bar G
9 Save the file as EO7Try_xx in the location where
your teacher instructs you to store the files for 1 Stock Purchases
this lesson. 2
Share Cost  Commission
0 Add a header that has your name at the |eft, the 3 | Ticker Price | Quantity Amount Commission Basis | Percentage
date code in the center, and the page number :] MSEN : -‘;\‘-‘MI 2°°| 55}2::88-"0' 55"-‘-‘5 $5,897.95
. F 1.95 1,1001=B5/C5 19.95
cpde at the right, and change back to Normal o |BAC " = 7 59.95
view. 7 |DIS $34 Cell addresses $9.95
2 ‘otal
Click cell F4 to select it. : accdorcoded |

Type =D4+E4, and press [~ .

Click cell D5 to select it. 0
@ Save the E07Try_xx file, and leave it open to
use in the next Try It.

Press to finish the formula.

Type =, click cell B5, type *, and click cell C5.

0000

Ilsing Arithmetic Operators m When a formula has multiple operators of the same
precedence level, such as multiple multiplication
m Use the following standard arithmetic operations, Excel performs the calculations from
(mathematical) operators in formulas: left to right.
+ Addition m Keeping the order of mathematical operations
- Subtraction in mind, the easiest way to control which part
* Multiplication of a complex formula is calculated first is to use
parentheses. Here are two examples:
/ Division
A Exponentiation =8+3*5 result: 23
m Excel performs mathematical operations in a Excel multiplies first, then adds.
particular order, called order of precedence.
This is the order in which Excel calculates: =(8+3)"5  result: 55
1. Operations enclosed in parentheses. Excel adds the values in parentheses, then

. Exponentiation. multiplies.

2
3. Multiplication and division.
4. Addition and subtraction.
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m Using Arithmetic Operators

In the EO7Try_xx file, click cell G4 to select it.
Type =E4/F4 and press .

Press [<] to select cell F5.

Type =B5*C5+E5 and press [128].

v The formula you just entered is an alternate way of
performing a calculation you created earlier. You could
also enter this formula as =D5+E5 to calculate the
correct result,

(-~ X~ N

© Incell G5, type =E5/(B5*C5+E5) and press

==

v The formula you just entered is an alternate way of
performing a calculation you created in cell G4. You could
also enter this formula as =E5/F5 to calculate the correct
result,

G Save the E07Try_xx file, and leave it open to

use in the next Try It.

Editing a Formula

m Excel automatically provides assistance in
correcting common mistakes in a formula
(for example, omitting a closing parenthesis).

m You can edit a formula as needed to update its
calculation or if you see an error message such
as #NUM! or #REF! in the cell.

m Editing a Formula

m Editing a formula works just like editing any other

data in a cell. Click the cell, and then press [ or
double-click the cell to enter edit mode. Work in the
cell or the formula bar to make the changes, and
then press or click the Enter button « on the
formula bar to finish the entry.

v Function lock must be enabled to use the function keys.

@ nthe EO7Try xx file, click cell F5 to select it,
and press [ to enter edit mode.

Editing in the formula bar

|5um - | : | x v £ || =£5/{B5*Cortes)|
v If needed, press the F Lock key to turn function lock on. . . ; . A A -
replace the selection, and press to finish the ' Stock Purchases
Change' ) Share Commission

Quantity Amount Commission CostBasis Percentage
200 $5,888.00, $9.95 $5,897.95 0.1687%

With cell G5 selected, drag over (B5*C5+E5) in | cker Price

4 MSFT | $29.44

the formula bar to select it. 5]F I_ 511.95I 1,1m_| S13,145.ml 519.95_| S13,145.m| :Es/[ns*cs»_ﬂ_
6 |BAC $19.95 250 $9.95

Type F5 to replace the selected part of the 7 |ois o E— e

formula, and press . 8 Total

Save the E07Try_xx file, and leave it open
to use in the next Try It.

® 00 O

m Drag the fill handle over the range of cells to fill with
the formula.

m Also use the Fill button [#] in the Editing group on
the HOME tab to fill formulas.

Copying a Formula Using the Fill Handle

m You can use the fill feature to copy a formula that
you've created to the cells below or to the right of it.

m Excel automatically adjusts cell addresses so the
filled formulas apply to the correct data.

v Lesson 8 explains more about how and why Excel adjusts
cell and range addresses.
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m Copying a Formula Using the Fill Handle

In the EO7Try_xx file, click cell D5 to select it.

Drag the fill handle down through cell D7 to fill
the formula.

Click cell F5 to select it.

Drag the fill handle down through cell F7 to fill
the formula.

(5]
(6]

Click cell G5 to select it.

Drag the fill handle down through cell G7 to fill
the formula.

Save the E07Try_xx file, and leave it open to
use in the next Try It.

The most basic and perhaps most often used
function is the SUM function, which adds the
values in the specified cells or range together.

You can enter the SUM function by typing it into the
cell just like any other cell entry. For example, you
could enter =SUM(A6,A9,B12) or =SUM(A6:B9).

v Formulas and functions are not case sensitive, so an entry
like =sum(a6:b9) would calculate correctly. This book shows
cell addresses, formulas, and functions in uppercase to
make them easier to read in the text.

m Using the Sum Function

=)

Enclose the cell addresses or range to sum
in parentheses, and use commas to separate
individual cell references.

Enter the SUM function more quickly using one
of the following three methods:
e Press + 3.

e Click the Sum button 2 in the Editing group
on the HOME tab. Note that this button is also
called the AutoSum.

e Click the AutoSum button 2 AuteSum ~ in the
Function Library group on the FORMULAS tab.

In the EO7Try_xx file, click cell F8 to select it.

On the HOME tab, click AutoSum 2. Excel
automatically starts the formula and selects the
range above it.

v/ If the selected range is incorrect, you can drag to
change it.

Press to finish the SUM formula.

Save and close the file, and exit Excel.

Summing a column of data

| SUM

e | H ‘ x v & H =SUM(F4:F7)

A B C D E E G

: Stock Purchases

2

3
4
5
6
7
8

| S|

3w

Share Commission

Ticker Price  Quantity Amount Commission CostBasis Percentage
"

MSFT $29.44 200 $5,888.00 59.95” $5,897.95, 0.1687%

F $11.95 1,100 $13,145.00 $19.051$13,145.00 0.1515%

BAC $19.95 250 $4,987.50 $9.05] $4,087.50! 0.1991%

DIS $34.09 350 $11,931.50 $9.951$11,931.50!  0.0833%
Total =SUM(Fa:F,

SUM(num‘herL [number], ...)
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In this project, you will add basic formulas to a spreadsheet using the skills you learned in this lesson.

DIRECTIONS

1. Start Excel, if necessary, and open the
E07Practice file from the data files for this lesson.

2. Save the file as E07Practice_xx in the location
where your teacher instructs you to store the files
for this lesson.

3. Add a header that has your name at the left, the
date code in the center, and the page number code
at the right, and change back to Normal view.

4. Click cell B12, type =B8+B9+B10+B11, and press
twice.

5. Type =B12/G12, and press [==1 . Excel should

display a #DIV/0! error message because cell G12
is currently empty.

#DIV/0!

© e N

10.

11.

Click cell C12 to select it.
Type =sum(C8:C11), and press .
Click cell G8 to select it.

Type =B8+C8+D8+E8+F8, and press .Your
worksheet should look like the one shown in
Figure 7-1.

With your teacher’s permission, print the
worksheet. Submit the printout or the file for
grading as required.

Save and close the file, and exit Excel.

Figure 7-1

Exfoliating Salt
Scrub
Serv004

Aromatherapy
Facial
Serv005
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You are the Accounts Receivable Supervisor at the Serenity Health Club. You have some new data in a
spreadsheet, and need to add basic formulas to calculate the data.

DIRECTIONS

1.

Start Excel, if necessary, and open the E07Apply
file from the data files for this lesson.

Save the file as EO7Apply_xx in the location

where your teacher instructs you to store the files
for this lesson.

Add a header that has your name at the left, the
date code in the center, and the page number code
at the right, and change back to Normal view.
Click cell D12 to select it and sum the values in the
cells above.

Drag the fill handle right through cell G12 to fill the
formula.

Click cell G8 and double-click the fill handle to fill
the entry down the column.

. Click cell B14 and drag the fill handle right through

cell F14. When you release the mouse button, you
should see the error message #DIV/0! in each of
the filled cells. This is because Excel changed the
reference to cell G12 and you don't want it to do that.

Figure 7-2

1 Serenity Health Club

2

e L2

A B =

$665 $600
$550 $600
$575 $550
$600 $550

Percentage

8.

9.

10.

1.

D

Edit each of the formulas in the range C14:F14 to
change the divisor (the right cell address) to G12.

Select the range B14:F14. Look in the status bar
next to the view buttons. The sum displayed there
should be 100.00%, meaning that the corrected
formulas each accurately calculate the percentage
of the total. Your worksheet should look like the
one shown in Figure 7-2.

v When you want to see a quick sum of cells without building
a formula, drag over the cells and check the status bar.

With your teacher’s permission, print the
worksheet. Submit the printout or the file for
grading as required.

Save and close the file, and exit Excel.

E F G

[»]

$445 $400 $150  $2.260
$550 $225 $300  $2.225
$575 $300 $450  $2,450
$625 $225 $300  $2.300

I Sum of selected cells l -

Sheet ®

AVERAGE: 20.00%

Kl / | [
H

COUNT: 5 SUM: 100.00%
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Lesson 8

Copying and Pasting

> What You Will Learn

Copying and Pasting Data

Copying Formats

Copying Formulas Containing a Relative Reference
Copying Formulas Containing an Absolute Reference

Software Skills Excel provides many time-saving shortcuts to help you enter
data and build formulas in your worksheets. For example, you can use the copy
and paste features to reuse data and formulas in the same worksheet, in another
worksheet, or in another workbook. You also can copy formats. When copying
formulas, you need to understand how to keep a cell reference from changing if
needed.

What You Can Do

Copying, Cutting, and Pasting Data

m  When you copy data, the copy is placed on the Clipboard.

m After you copy data, paste it to place the copy from the Clipboard to the new
location.

m You can copy labels, values, and formulas to another cell, a range of cells,
another worksheet, or another workbook. You also can copy Excel data to
documents created in other programs, such as Word.

m To copy a selected cell or range of data to a new location, use the Copy E& and
Paste 4 buttons in the Clipboard group on the HOME tab of the Ribbon.
v/ +[c] and + v are the shortcuts for copying and pasting, respectively.

m If the cells to which you want to copy data are adjacent to the original cell, you
can use the fill handle to copy the data.

m Excel automatically copies the formats applied to data, which overrides any
formatting in the destination cell.

m You can copy just the data and formulas without copying formatting.
v Clicking the bottom half of the Paste button, with the arrow on it, displays a menu with additional

paste options. For example, you can paste formulas, formulas with number formatting, keep the
column widths, and so on.

WORDS TO KNOW

Absolute reference

A cell address in a
formula that will not
change when you copy
the formula to another
location. Dollar signs
indicate an absolute cell
reference.

Clipboard

A Windows feature that
holds data or graphics
you cut or copy prior

to pasting to another
location.

Copy

The command used to
place a copy of data from
the selected cell or range
on the Clipboard.

Format Painter

A tool that enables you
to copy formatting from
a cell and apply it to
another cell or range.

Paste

The command used

to place data from the
Clipboard to a location on
the worksheet.

Relative reference

A cell address that can
change in a copied
formula, so the new
address is expressed
in relation to the cell
containing the copied
ormula. For example,

if you copy a relative
reference to A5 one row
down, it becomes AB.
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m Pasting overwrites data in the destination cell or
range.

B You can link data as you paste it so the data
changes automatically whenever the original data
changes. Lesson 36 explains how to link data.

m Copying, Cutting, and Pasting Data

0000

Salesperson  Expenses

Start Excel.

Open the E08Try file from the data files for this
lesson.

Save the file as E08Try_xx in the location where
your teacher instructs you to store the files for
this lesson.

Add a header that has your name at the left, the
date code in the center, and the page number
code at the right, and change back to Normal
view.

Click cell H5 to select it.

On the HOME tab, click Cut .
Click cell E5 to select it.

On the HOME tab, click Paste K.

Copied range

I
Accounts Expense g Amount Above or Below Median

00000060

(<)

Drag over the range A3:E4 to select it.
On the HOME tab, click Copy E&.
Click cell A13 to select it.

On the HOME tab, click Paste ).

Drag over the range A5:C11 to select it.
On the HOME tab, click Copy E&.
Click cell A15 to select it.

On the HOME tab, click the Paste drop-down
arrow > Values [,,. Excel pastes the range
without pasting the formatting applied in the
original range.

Press to remove the selection marquee
from the copied range.

v A selection marquee is a visible dashed line around a
selected area.

Click cell B21 to select it. You still need a
formula in this cell, so you need to update it.

Type =MEDIAN(B15:B20 and press [==| . Excel
automatically fills in the closing parenthesis for

5 |Jones $ 3,500 6 583.3333 -1549.5 you.

& |Smith $ 2995 2 . 3

7 [Thomas s 65 a @ Save the E08Try_xx file, and leave it open
AL EE e to use in the next Try It.

9 |vegas S 2,933 2

10 |Lewis s 7,800 4

11 |Median 3 5,050

13 E_ | \ |
14 [Salesperson  Expenses |Amoums ‘Expense dAmountﬁbove or Below Median

@




Learning Microsoft Excel 2013 | Chapter1

Copying Formats u

m You can copy formatting from one cell to another,
without copying the original cell’s value.

m The Format Painter button ¥ in the Clipboard
group on the HOME tab enables you to copy [
formatting from one cell to another.

m Format Painter copies a cell’s font, font size, font
color, border, fill color, number formats, column
widths (in some cases), cell alignment, and
conditional formatting (formatting that depends
on the current value in a cell).

m Copying Formats

Select the cell with the formatting to copy, and then
on the HOME tab. in the Clipboard group, click
Format Painter *¥ . Click a destination cell or drag
over a destination range to apply formatting in that
location.

To paste the formatting to multiple areas, double-
click the Format Painter button ¥ . It will remain
on until you click it again or press to turn it off.

In the E08Try_xx file, click cell E4 to select it.
On the HOME tab, click Wrap Text =¢.
On the HOME tab, click Format Painter ¥ .

Drag over cells A4:D4 to copy the wrapping
to them.

Click the column header for column C, and drag
its right border to the right to resize the column
to a width of 9.00.

Click cell E4 to select it.
On the HOME tab, click Format Painter <«

00 O 000o
00 © 860 O

Drag over cells D14:E14 to copy the wrapping
to them.

Click cell B5 to select it.
Double-click the Format Painter button .

Drag over cells D5:E11 to copy the number
formatting.

Scroll down and drag over cells B15:B21 to
copy the number formatting.

Press )

Save the E08Try_xx file, and leave it open
to use in the next Try It.

Copying Formulas Containing u
a Relative Reference

m Formulas often have relative references to cells.
This means that if you copy the formula to another u
location, the cell reference changes to reflect the
position of its copied location relative to the original -
location.

For example, the formula =B4+B5 entered in
column B becomes =C4+C5 when copied to
column C, =D4+D5 when copied to column D,
and so on.

Relative references make it easy to copy formulas
across a row to total values above, for example.

Relative references also work best when you want
to fill formulas across a row or down a column.

m Copying Formulas Containing a Relative Reference

In the E08Try_xx file, scroll down so row 4 9
is the first row visible.

Click cell D5 to select it.
On the HOME tab, click Copy E&i.
Drag over the range D6:D10 to select it. e

Press . Excel pastes the formula to fill the
destination range.

v In some cases, you can select a range or click in the
upper-left cell of a range and press to complete
a paste rather than using the Paste button.

Drag over the range D5:D10 to select it.

(continued)
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m Copying Formulas Containing a Relative Reference (continved)

A pasted formula with relative references

| D5 _ fe | =Bs/cs
A B s D E
Amount

Expense Above
per or Below

4 |Salesperson Expenses  Accounts Account Median

_ 5 |Jones $ 3,500 6% 583 % (1.550)

& |Smith $ 2995 21% 1.4%98

7 |Thomas $ 6,599 4% 1,650

8 |Weisbard $ 8055 5% 1.611

_? |Vegas $ 2933 215 1,467

10 |Lewis $ 7.800 4% 1950

$ 5050

11 |Median

®©@ O 06009

Press + [c].
Click cell D15 to select it.
Press + .
Click cell B15 to select it.

Type 4240 and press . The value in cell D15
recalculates as you'd expect.

Click cell D15 to select it. The cell references in
the formula have been updated to refer correctly
to other cells on row 15.

Save the E08Try_xx file, and leave it open to
use in the next Try It.

Copying Formulas Containing
an Absolute Reference

B Sometimes, you do not want a cell reference to
change when you copy the formula, so you need
to create an absolute reference.

m To make a cell reference absolute, enter a dollar
sign ($) before both the column letter and row
number of that cell in the formula.

m For example, the formula =$B$4+$B$5 contained
in a cell in column B remains =$B$4+$B$5 when
copied to column C. The cell addresses do not
adjust based on the new formula location.

You can also create mixed cell references, where
the column letter part of a cell address is absolute,
and the row number is relative, or vice-versa.

For example, the formula =B$4+B$5 contained in
a cell in column B changes to =C$4+C$5 when
copied to any cell in column C. The cell addresses
partially adjust based on the new formula location.

Press the [ key as you type a cell reference in
a formula to change to an absolute reference.
Pressing [ additional times cycles through the
mixed references and then returns to a relative
reference.

m Copying a Formula Using an Absolute Reference

In the E08Try_xx file, click cell E5 to select it.

Drag the fill handle down through cell E10 to fill
the formula. Cell E8 displays an error message,
so you know there must be a problem with the
copied formula.

Click cell E5 to select it again. Notice that it
subtracts the median value calculated in cell
B11 from Jones’ expenses. You need for each of
the formulas in the column to subtract the value
in B11 rather than changing, so you need to
change to an absolute reference for cell B11.

Copying a formula with an absolute reference

A E C D

Expense Analysis

Absolute reference

Amount

E F

Expense Above or
per

Accounts Account

Below

Salesperson  Expenses Median

Jones S 3,500 6 $ 582 S (1,550)
Smith $ 2,995 2 $ 1,498 | § (2,055)
Thomas S 6,599 4 % 1,650 | & 1,550
Weisbard ] 8,055 5 S L,611|S 3,006
Vegas g 2,933 2 $ 1,467 | § (2,117)
Lewis ] 7,800 4 5 1,950 S 2,751
Median S 5,050 =

(continued)
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m Copying a Formula Using an Absolute Reference (continved)

© © 00 60

Press [ to enter edit mode.

Press [] to add dollar signs for the row letter
and column number for cell B11 in the formula,
and then press to finish the change.

Click cell E5 to select it.

Drag the fill handle down through cell E10 to fill
the formula. Now it fills correctly.

With the range E5:E10 still selected, on the
HOME tab, click Copy ER.

Click cell E15 to select it.

[10)

© ® 06

On the HOME tab, click Paste I74. Look at

the formula bar. The absolute reference in the
formula still refers to cell B11, but for this set of
data, you need for it to refer to cell B21.

Click cell E15 to select it.

Use the method of your choice to change the
absolute reference in the formula from $B$11
to $B$21.

With cell E15 selected, drag the fill handle down
through cell E20 to fill the formula.

Save and close the file, and exit Excel.

Lesson 8—Practice

In this project, you will copy and paste formatting and formulas using the skills you learned in this lesson.

DIRECTIONS

1.

N as

Start Excel, if necessary, and open the
E08Practice file from the data files for this lesson.

Save the file as E0O8Practice_xx in the location
where your teacher instructs you to store the files
for this lesson.

Add a header that has your name at the left, the
date code in the center, and the page number
code at the right for each sheet, and change back
to Normal view.

Click cell D9 to select it.

Click HOME > Copy EB.

Drag over the range D10:D19 to select it.

On the HOME tab, click Paste .

8.
9.
10.
11.
12.

13.

14.

Drag over the range J9:K19 to select it.
On the HOME tab, click Copy E&.
Click cell B9 to select it.

On the HOME tab, click Paste .

Drag over the range J9:K19 to select it and clear
the contents. Your worksheet should look like the
one shown in Figure 8-1 on the next page.

With your teacher’s permission, print both
worksheets. Submit the printouts or the file for
grading as required.

Save and close the file, and exit Excel.
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Figure 8-1

D E F G

|l Voyager Travel Adventures
2
Q) Fco Wilderness Adventure
W Tell City Thrill Seekers Club
Gl 10/6/14-10/12/14
6
7

Their Their

Cost Total Our Cost Our Total Our
8 |Item per Unit | Units Cost per Unit  Cost Profit
9 |Bus to white water launch point (30 adventurers, max) 51,125 1 $1,125 731.25
10 | White water raft, first day (4 adventurers max) 3450 3 31,350
11 |White water raft, second day (4 adventurers max) 5450 3 $1,350
12 |River gear rental 5110 12 51,320
13 | Transportation of gear to hike point $1,500 1 51,500
14 | Camping gear rental per person 525 12 5300
15 |Hiking guides (1 per 4 adventurers), three days 5150 3 51,350
16 |Rock climbing gear rental per person 5125 12 51,500
17 |Food and water, per person 5275 12 53,300
18 |Bus return trip (30 adventurers, max) 51,675 1 31,675
19 |Adventurer's insurance 5315 12 53,780
20 $18,550 0 0

Lesson 8—Apply

As an Adventure Coordinator for Voyager Travel Adventures, you make all the arrangements necessary to create
a unique and thrilling adventure vacation for your clients. Today, the Tell City Thrill Seekers Club has asked for an
estimate of expenses per person for a special trip that combines white water rafting, back country hiking, and rock
climbing. You have started both a trip budget for the club and a profit worksheet. To complete the two worksheets,
you need to copy formulas, data, and formatting.

DIRECTIONS 5. Click cell E9 to select it, and paste the formula. An
error message appears in cell E9, so you know
there’s a problem with the formula. Notice that to
calculate the discounted price, the formula has to

1. Start Excel, if necessary, and open the E08Apply
file from the data files for this lesson.

2. Save the file as EO8Apply_xx in the location use the discount percentage in cell G4. That cell
where your teacher instructs you to store the files for reference needs to be changed to an absolute
this lesson. reference for the formula to copy correctly.

3. Adda heac_jer that has your name at the left, the 6. In Edit mode, change the C4 cell reference, to an
date code in the center, and the page number absolute reference to cell G4.

code at the right for each sheet, and change back
to Normal view.

4. Click cell 19 to select it, and copy the formula.

7. Also in Edit mode, change the #REF! cell
reference to B9.

8. Copy cell E9 and paste it to the range E10:E19.
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9. Delete the contents of cell 19. 14. Click the cell range F20:G20, and apply the
10. Enter the formula =C9*E9 in cell F9. Copy or fill the Currency number format. Apply the Total cell style
formula down through cell F19. to the same range. Your worksheet should look like
11. Enter the formula =D9-F9 in cell G9. Copy or fill the one shown in Figure 8-2.

12. Select cells F20:G20, and apply the Total cell worksheet. Submit the printout or the file for
grading as required.
style to them.

13 16. Save and close the file, and exit Excel.

. Click cell G5, and apply the Currency number
Figure 8-2

format to it.

D E F G
[l Voyager Travel Adventures
2
) Eco Wilderness Adventure
EW Tell City Thrill Seekers Club
Wl 10/6/14-10/12/14
6
7
Their Their
Cost Total Our Cost OurTotal Our
Item per Unit  Units Cost per Unit Cost Profit
9 |Bus to white water launch point (30 adventurers, max) $1,125 1 $1,125 §731.25 $731.25 $393.75
10 |White water raft, first day (4 adventurers max) 5450 3 $1,350| 5$292.50 $877.50 $472.50
11 |White water raft, second day (4 adventurers max) 5450 3 $1,350| 5292.50 $877.50 5$472.50
12 |River gear rental 5110 12| 51,320 $71.50  $858.00 5$462.00
13 |Transportation of gear to hike point 51,500 1/ 51,500/ $975.000 $975.00 $525.00
14 |Camping gear rental per person 525 12 3300 316.25 $195.00/ 5$105.00
15 |Hiking guides (1 per 4 adventurers), three days 5150 9 51,350  S$97.50  S$877.50 $472.50
16 |Rock climbing gear rental per person 5125 12| 51,500 $81.25  $975.00 5$525.00
17 |Food and water, per person 5275 12 $3,300 $178.75 $2,145.00 $1,155.00
18 |Bus return trip (30 adventurers, max) 51,675 1 51,675 51,088.75 51,088.75 5$586.25
19 |Adventurer's insurance 5315 12 $3,780 $204.75 52,457.00 51,323.00
20 $18,550 $12,057.50 $6,492.50
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Lesson 9

Techniques for
Moving Data

> What You Will Learn

Inserting and Deleting Cells

Inserting, Deleting, Hiding, and Unhiding Columns and Rows
Cutting and Pasting Data

Using Drag-and-Drop Editing

Transposing Columns and Rows

WORDS TO KNOW Software Skills After you create a worksheet, you may want to rearrange data
or add more information. For example, you may need to insert additional rows to

Cut a section of your worksheet because new employees have joined a department

The command used to or been promoted. With Excel’s editing features, you can easily add, delete, and

remove data from a cell rearrange cells and entire rows and columns. You can also move or drag and drop

orrange of cells gnd sections of the worksheet with ease.

place it on the Clipboard.

Drag-and-drop
A method used to move What You Can Do

or copy the contents of a

range of cells by dragging  Inserting and Deleting Cells
the border of a selection

from one location in a B You can insert or delete cells when necessary to change the arrangement of the
worksheet and dropping data on the worksheet.

it in another location. m  When you select a cell or range of cells, you can use the Insert and Delete
Transpose buttons in the Cells group on the HOME tab to insert and delete cells. You also
A method to rearrange can click the drop-down arrows for these buttons for more commands, or right-
data by switching the click a selected cell and use the Insert and Delete commands on the shortcut
positions of columns and menu.

rows. m The Insert or Delete button will add or remove the number of cells specified by

your selection.

m When you insert a cell in a worksheet, existing cells shift their position down. For
example, if you select cell B2 and then insert a cell, the data that was in cell B3
is shifted down and becomes cell B4.

m When you select a range of cells and then click the Insert or Delete buttons, the
Insert or Delete dialog box will open.

m You can choose the direction to shift the surrounding cells in the Insert or Delete
dialog box, for example, right or down.
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After inserting a cell or group of cells, you can use
the Format Options button to choose whether or not
formatting should be applied to the new cell(s).

m Inserting and Deleting Cells

@ © © o0

Chapter 1

When you delete a cell, existing cells shift left or up
to close the gap. Any data in the rows or columns
you select for deletion is erased.

Start Excel.

Open the E09Try file from the data files for this
lesson.

Save the workbook as E09Try_xx in the location
where your teacher instructs you to store the
files for this lesson.

Add a header that has your name at the left, the
date code in the center, and the page number
code at the right, and change back to Normal.

Click cell C6 to select it.

On the HOME tab, in the Cells group, click the
Insert button &=.

v Be sure to click the top part of the Insert button, not the
drop-down arrow on the bottom part.

Click the Insert Options button “¥ - next to the
cell, and click Format Same As Below.

(8]

Type 3091, and press + [==] . Notice that the
number is formatted for currency.

Right-click on cell C6, select delete, make sure
Shift cells up is selected, and click OK.

Save the E09Try_xx file, and leave it open to
use in the next Try It.

The Delete dialog box

Delete
() shift cells Jeft

Gl Entire row
D Entire column

OK

Inserting, Deleting, Hiding, and Unhidin
I 4 /4 14
Columns and Rows

You can insert or delete columns or rows when
necessary to change the arrangement of the data
on the worksheet.

When you select a row or column, or multiple rows
or columns, you can use the Insert & and Delete
2 puttons in the Cells group on the HOME tab

to insert and delete columns and rows. You also
can right-click a selected column or row’s heading
and use the Insert and Delete commands on the
shortcut menu.

v Drag over multiple row or column headings to select
multiple rows or columns. Then, using the shortcut menu to
insert or delete will add or remove the number of rows or
columns specified by your selection.

When you insert column(s) in a worksheet,

existing columns shift their position to the right. For

example, if you select column C and then insert two
columns, the data that was in column C is shifted to
the right and becomes column E.

If you insert row(s) in a worksheet, existing rows
are shifted down to accommodate the newly
inserted row(s). For example, if you select row 8
and insert two rows, the data that was in row 8 is
shifted down to row 10.

After inserting a column or row, you can use the
Insert Options button <¥ - to choose whether or not
formatting from a nearby row or column should be
applied to the new rows or columns.

When you delete a column or row, existing columns
and rows shift left or up to close the gap. Any data
in the rows or columns you select for deletion is
erased.

You can also hide columns or rows temporarily
and then redisplay them as needed. Right-click
the column/row heading and click Hide. Drag over
headings surrounding the hidden row/column,
right-click, and click Unhide.
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m Inserting, Deleting, Hiding, and Unhiding Columns and Rows
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In the E09Try_xx file, right-click the column B
column heading and click Hide on the shortcut
menu.

Drag across column headings A though C and
right-click the selected headings. Click Unhide
on the shortcut menu.

Click the column B column heading to select the
column.

On the HOME tab, click Delete = . Excel
removes the column.

v Be sure to click the top part of the Delete button, not the
drop-down arrow on the bottom part.

Click the column C column heading to select it.
On the HOME tab, click Insert &-.

v Be sure to click the top part of the Insert button, not the
drop-down arrow on the bottom part.

Make the following entries in the new column,
starting in cell C3:

February

8282

9087

10443

9731

8367

(8]
9]

®©@00 6

Fill the formulas from cells B9 and B10 to the
right to cells C9 and C10.

Right-click the row 8 row heading and click Hide
on the shortcut menu.

Drag across row headings 7 though 9 and right-
click the selected headings. Click Unhide on the
shortcut menu.

Click the row 8 row heading to select it.
On the HOME tab, click Insert &=

Make the following entries in the new row,
starting in cell A8:

Vegas

8042

6639

8088

Save the E09Try_xx file, and leave it open to
use in the next Try It.

Cutting and Pasting Data

m To move data from one place in the worksheet
to another, use the Cut %, and Paste [} options
in the Clipboard group on the HOME tab. This
removes the data from its original location.

m When you cut data from a location, it is temporarily
stored on the Clipboard. That data is then copied
from the Clipboard to the new location when you
paste.

If data already exists in the location you wish to
paste to, Excel overwrites it.

Instead of overwriting data with the Paste
command, you can insert the cut cells and have
Excel shift cells with existing data down or to the
right.

When you move data, its formatting moves with it.
You can override this and move just the data using
choices on the Paste button’s drop-down list.
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m Cutting and Pasting Data

0 In the E0O9Try_xx file, drag over the range A8:E9 Q On the HOME tab, in the Clipboard group, click
to select it. Paste .

0 On the HOME tab, in the Clipboard group, click v Be sure to click the top part of the Paste button, not the
Cut X . drop-down arrow on the bottom part.

9 Click cell G4 to select it. e Save the changes to E09Try_xx file, and leave it

open to use in the next Try It.

Using Drag-and-Drop Editing ® You can use drag-and-drop to move data and to
copy it. To copy data using drag-and-drop, simply
m The drag-and-drop feature enables you to use the hold down the key as you drag.
mouse to copy or move a range of cells simply by m Insert, delete, move, and copy operations may
dragging them. affect formulas, so you should check the formulas
m To use drag-and-drop, select a range to copy or after you have used drag-and-drop to be sure that
move, and then you use the border surrounding the they are correct.
range to drag the data to a different location. When ®m When a drag-and-drop action does not move data
you release the mouse button, the data is “dropped” correctly, use the Undo feature to undo it.

in that location.

m An outline of the selection appears as you drag
it to its new location on the worksheet.

m Using Drag-and-Drop Editing

o In the E0O9Try_xx file, drag over the range A7:E7 Moving a range with drag-and-drop
to select it.
' _ A | B | € | D | E
0 Point to the border of the selection. When the By
mouse pointer changes to a four-headed arrow, ,
dra.g down one row. When the ScreenTip reads s | Salesperson | January  February March Total
AB8:E8, release the mouse button. 4 Domes =7 S T
€ Drag over the range G4:K4 to select it. SlSmith 39,30|  39,087) 33930| 522,947
& |Thomas $5,909 $10,443 $6,965 $23,317
o Use drag-and-drop to move the selection to row 7 |Weisbard [ 5,056 $9,731/ $7,933 $22,720
7 of the sales data. 8 N l
9 |Lewis “laaza $7,693 $8,367 310,111 526,176
9 Click the row 9 row heading to select it. 10 el $36,252  $45910  $40,939  $123,101
0 On the HOME tab, click Delete & . R —— — e
o Save the changes to E09Try_xx file, and leave it

open to use in the next Try It.




Chapter1 | Learning Microsoft Excel 2013

Transposing Columns and Rows m To place the transposed data, right-click the first

cell where you want the tranposed data to be

m You can use the transpose feature to rearrange the pasted, and choose Transpose [2: in the Paste
columns and rows of data in a worksheet. Options menu.

m To use the transpose feature, select the data you m Transposing may affect formulas, so you should
want to transpose, which can include row or column check the formulas after you have used the
labels, and then copy it. transpose feature to be sure that they are correct.
v You must use Copy ER with the transpose feature; you m When a transpose action does not move data

cannot use Cut ¥, . correctly, use the Undo feature to undo it.

m Transposed data must be placed in blank cells.

m Transposing Columns and Rows

0 In the E09Try_xx file, select the cell range The Transpose button in the
A3:D8. Paste Options drop-down menu
0 On the HOME tab, in the Clipboard group, click X cut
Copy Ea. By Copy
© Right-click cell A13. i o
o In the Paste Options menu, click Transpose &D ;3 ‘:;; EE %.‘ ;
2 . The column headings have now been Paste Special. N

transposed to row headings, and vice versa.
Notice that the data has been transposed also.

Insert Copied Cells... Transpose

Delete...
9 Save and close the file, and exit Excel.
Clear Contents
IE Quick Analysis
Filter 3
Sort 3

LA Insert Comment

Format Cells...
Pick From Drop-down List...

Define Name...
% Hyperlink...
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Lesson 9—Practice

Chapter 1

In this project, you will insert, delete, hide, and unhide columns and rows using the skills you learned in

this lesson.
DIRECTIONS 8.
1. Start Excel, if necessary, and open the
E09Practice file from the data files for this lesson. 9.
2. Save the file as E09Practice_xx in the location 10.
where your teacher instructs you to store the files 1.
for this lesson.
3. Add a header that has your name at the left, the 12.
date code in the center, and the page number code
at the right, and change back to Normal view. 13.
4. Click the row 14 row heading to select it.
5. On the HOME tab, click Insert & .
6. Click the row 4 row heading to select it. 14.
7. Move the mouse pointer over the border of the

selection, press and hold [c=], and drag the
selection down to row 15. When you release
the mouse button, Excel copies the selection.

Lesson S—Apply

Click cell A15 to select it, type Hourly Employees,
and press [ .

Click the column D column heading to select it.
On the HOME tab, click Delete >

Right-click the row 14 row heading and select
Hide.

Click the row headings for rows 13-15, right-click,
and select Unhide.

With your teacher’s permission, print the
worksheet. Submit the printout or the file

for grading as required.

Save and close the file, and exit Excel.

You are the Payroll Manager at Whole Grains Bread. The conversion to an in-house payroll system is next week,
and you want to test out a payroll worksheet the staff will use to collect and enter payroll data in the computer
system. You need to finish entering data and formulas in the worksheet. This will require adding, deleting, hiding,
and unhiding rows and columns, and moving data by cutting and pasting and drag-and-drop techniques. You also
will transpose the hourly employee data to show a different way of presenting this information.

DIRECTIONS S
1. Start Excel, if necessary, and open the EO9Apply

file from the data files for this lesson. 6.
2. Save the file as E09Apply_xx in the location 1.

where your teacher instructs you to store the files

for this lesson.
3. Add a header that has your name at the left, the

date code in the center, and the page number code

at the right, and change back to Normal view. 8.
4. Select the range B5:J13 and move it left one 0.

column.

Select the range B16:H24 and move it left one
column.

Adjust column widths as needed.

Select the range G5:113, press and hold the
key, and use drag-and-drop to copy the data to the
range H16:J24.

v When using drag-and-drop to copy data, remember to use
the key.
Select row 12, and insert a new row.

Cut the range A22:D22, and paste it in the new
row 12.
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10. In row 12, change the Rate to 765. For the rest of 16. Right-click cell A27.

the columns, fill the formulas down from the row 17. In the Paste Options menu, click Transpose [3s
above to row 12. . Adjust the column widths, if necessary. Your
11. Delete row 22. worksheet should look like the one shown in
12. Select row 15 and hide the row. Figure 9-1.
13. Select column B and hide the column. 18. With your teacher’s permission, print the

worksheet. Submit the printout or the file for
grading as required.

19. Save and close the file, and exit Excel.

14. Select the cell range A17:J24.
15. On the HOME tab, in the Clipboard group, click

Copy E&.
A C D E F G H ] K
; Whole Grains Bread
2 |Home Office Payroll
3
EM Salaried Employees
Regular
5 |Employee Name Rate Hours Gross Pay  Fed Tax SS Tax State Tax  Net Pay
6 |AnthonySplendoria $  2,175.00 40.00 $2,175.00 $ 54375 S 169.65 S 65.25 51,396.35
7 |Eileen Costello ¢ 1,895.00 40.00 $1,895.00 $ 47375 S 147.81 $ 56.85 51,216.59
2 |carol Chen g 895.00 40,00 $ 895.00 § 22375 S 69.81 § 26.85 & 574.59
9 |Marty Gonzales s 684.00 40.00 S 684.00 S 171.00 S 53.35 S 20.52 S 439.13
10 |Maria Nachez 4 1,665.00 40.00 $1,665.00 S 41625 S 129.87 $ 49.95 51,068.93
11 |Mika Gritada $  1,023.00 40.00 $1,023.00 $ 25575 S 79.79 S 30.69 $ 656.77
12 |Vickie Helms g 765.00 40,00 § 765.00 $ 191.25 S 59.67 § 2295 & 491.13
13 |Randall Lohr s 1,545.00 40.00 $1,545.00 $ 386.25 S 12051 S 46.35 S 991.29
14 |Abe Rittenhouse 4 1,231.00 4000 $1,231.00 $ 307.75 S 96.02 S 36.93 $ 790.30
L[} Hourly Employees
Regular  Overtime
17 |[Employee Name Rate Hours Hours Gross Pay Fed Tax S5Tax  State Tax Net Pay
18 |Thomas Cortese s B8.25 40.00 200 S 35475 S 53.21 § 27.67 $ 1064 S 263.22
19 |Javier Cortez s 7.75 40.00 3.00 5 344.88 S 51.73 $ 2690 5 10.35 S  255.90
20 |Allen Gaines 4 7.25 40.00 6.00 $ 355.25 % 5329 ¢ 2771 5 1066 S  263.60
21 |Freda Gage g 8.00 40.00 300 §  356.00 S 5340 § 27.77 & 10.68 & 264.15
22 |Isiah Herron s 10.95 40.00 550 § 52834 5 79.25 S 41.21 5 1585 S 392.03
23 |Thomas Kaminski s 9.75 40.00 400 $ 44850 35 67.28 S 3498 5 1346 5 332.79
24 |Chris Nakao 4 11.25 40.00 3.00 $ 50063 9 75.09 $ 39.05 5 1502 § 37146
25
26
27 |Employee Name Javier Cortez  Allen Gaines Freda Gage Isiah Herron Thomas Kaminski Chris Nakao
28 |[Employee ID 21154 234535 27855 33252 37881 29958
29 |Rate s 775 % 7.25 & 8.00 5 1095 % 975 $ 1125
Regular
30 Hours 40.00 40.00 40.00 40.00 40.00 40.00
3 Overtime Hours 3.00 6.00 3.00 5.50 4.00 3.00
32 Gross Pay s 34488 S 355.25 S 356.00 $ 52834 S 448,50 5 500.63
33 Fed Tax s 51.73 S 53.29 $ 5340 5 79.25 S 67.28 S 75.09
34 55 Tax s 26.90 S 2771 & 2777 5 4121 § 3498 S 39.05
35 State Tax s 10.35 % 10.66 5 10.68 % 1585 $ 1346 § 15.02
36 Met Pay s 255.90 S§ 263.60 S 26415 S 392.03 S 332.79 S 37146
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Lesson 10

Sheet, Display, and Print

Operations

> What You Will Learn

Displaying, Printing, and Hiding Formulas
Printing Titles

Changing Orientation

Scaling a Printout

Previewing and Printing a Worksheet

Software Skills A few of the options available for adjusting a printout make

a great difference in how easy it is to read the worksheet data. Repeating rows or
columns with labels on multipage printouts ensures that the data will be identified on
every page; choosing the right page orientation ensures enough columns will fit on
screen; and scaling a printout to fit to a specified number of pages helps ensure that
rows or columns aren’t “orphaned” from the rest of the data. You might also want to
display and print formulas to review them and preview the worksheet so you can see
how it will look when printed.

What You Can Do

Displaying, Printing, and Hiding Formulas

m The Show Formulas command displays formulas in cells in which they are
entered rather than formula results.

m Showing formulas enables you to review the worksheet to ensure that the
formulas refer to the correct cells and ranges and accurately perform the desired
calculations.

m Print the worksheet with the formulas displayed to create a printout of the
formulas for later reference.

m Use the Show Formulas button = in the Formula Auditing group on the
FORMULAS tab to turn formula display on and off. You also can press + [

v The accent grave character (') is on the same key as the tilde, typically found to the left of the 1
on the row of numbers at the top of the keyboard or beside the Spacebar in rarer cases.

WORDS TO KNOW

Orientation

The position for
displaying and printing
text either horizontally
across the shorter side
of a page, the default
Portrait orientation, or
along the wider side of
the page, Landscape
orientation.

Print titles

Row and column labels
that reprint on each page
of a printout.

Scale
Adjust the size
proportionately.

Show Formulas

A command that enables
you to display the
formulas in a worksheet
so that you can check
them.
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m Displaying, Printing, and Hiding Formulas

Start Excel, if necessary, and open the E10Try
file from the data files for this lesson.

v It's often necessary to scale the sheet when formulas
are displayed because the formula display makes the

Save the file as E10Try_xx in the location where Ll

your teacher instructs you to store the files for
this lesson.

With your teacher’s permission, print
the worksheet by clicking the Print button.
Otherwise, click the Back button .

Press + [x] to toggle off the formula display.
v The[x] is usually above the [T28] key.

Save the E10Try_xx file, and leave it open
to use in the next Try It.

Scroll down so that row 105 is visible.
Click FORMULAS > Show Formulas P .
Click FILE > Print.

Under Settings, click No Scaling > Custom
Scaling > Fit Sheet on One Page.

(8]
(9]

@e0® O© ©

Formulas displayed in worksheet

A B C D E F
KLA-Tencor 32.25 1:29pm 5.4828B 3.356
MGM Resorts International 12.42 1:29pm 5.481B -37.953
China Eastern Air 1:12pm 5.441B 0
Flowserve Corp. 1:29pm 5.4318 25.771
Legg Mason Inc. 1:29pm 5.4118 3.915
Dr. Reddy's Labor 1:28pm 5.335B 2.587
American International 1:29pm 5.3348 -9.384
1:29pm

94 KLAC
95 |IMGM
96 CEA
97 |FLS 96.88
33.09
3L6
39.49
53.28

99 RDY
100 AIG

101 ATI Allegheny Technology 5.2508. 2.216

105 Averages =AVERAGE(CA:C101) =AVERAGE(F4:F101)

Printing Titles ® You also can use the Print Titles button [& in the

m Using the Sheet tab of the Page Setup dialog box, Page Setup group of the PAGE LAYOUT tab on the

you can specify rows or columns with the print
titles that need to appear on every page of a
printout.

v Print titles do not affect or replace worksheet headers or
footers.

Ribbon to add print titles.

v Click the dialog box launcher for the Page Setup group to
open the Page Setup dialog box.

The row and column labels make it possible for you
to identify the data on every page, which is useful
when the sheet has many rows or many columns
of information.
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m Printing Titles

@ nthe E10Try xxfile, add a header that has
your name at the left, the date code in the
center, and the page number code at the right,
and change back to Normal view.

Click PAGE LAYOUT > Print Titles =.

On the Sheet tab in the Page Setup dialog box,
click in the Rows to repeat at top text box, click
the Collapse Dialog box button, and then click
the row 3 row header. The row address for row
3, which holds the labels for the columns of
data, appears in the box.

Click OK.

Save the E10Try_xx file, and leave it open to
use in the next Try It.

Specifying print titles

‘ Page I Margins | Header{Faoter| Sheet ‘

Print area: |
Print titles
Rows to repeat at top: |53153|
Columns to repeat at left: |
Print
Dlgranes comnets (W) [¥
Dﬁlack and white -
Cell grrors as: | displayed u
|:| Draft guality

|:| Row and column headings
Page arder

@ Down, then aver

O Quer, then down

Print... | ‘PrintPreme'\._\r‘ | DOptions...

Changing Orientation

m You can change the orientation to help a
worksheet fit better on paper.

m The default orientation is Portrait (tall or vertical).

m Changing Orientation

m Changing to Landscape (wide or horizontal)
orientation allows for more columns to fit on each
page when a worksheet has many columns.

m Change orientation on the Page tab of the Page
Setup dialog box, or use the Orientation button
[} choices in the Page Setup group of the PAGE
LAYOUT tab.

o In the E10Try_xx file, click PAGE LAYOUT >
Orientation [** > Landscape.

0 Save the E10Try_xx file, and leave it open to

use in the next Try It.

m You can scale the data to print to a larger or
smaller size to help it fill a page or print on fewer
pages.

m Specify scaling in the Scaling section of the Page
tab of the Page Setup dialog box.

m You can scale the printout to a percentage of
normal size, or specify how many pages wide and
tall it should be.

v For many worksheets, changing to Landscape orientation
and then scaling to 1 page wide prevents orphaned columns
on a nearly blank page.

m You also can use the choices in the Scale to Fit
group on the Page Layout tab to specify the printout
Width and Height in number of pages or a Scale
percentage.
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m Scaling to Fit

@ Inthe E10Try xxfile, click the Page Layouttab, @€))  Click the Print Preview button.
and then click the dialog box launcher for the 0
Scale to Fit group.

At the bottom of Backstage view, click the Next
Page (right arrow) button to display the second
0 On the Page sheet, click the Fit to button, and page of the printout.

then adjust the accompanying text box entries to 6

set up the printout to be 1 page(s) wide by 2 tall. SEM D | S0y I, £l R i efpe

to use in the next Try It.

Previewing and Printing a Worksheet m  Settings you can change appear in the middle
column of the Backstage view. These include
m You may print the selected worksheet(s), an entire specifying how many copies to print, what printer
workbook, or a selected data range. to use, page orientation, page size, margins, and

v You learn how to print an entire workbook and a selected scaling.

range in Lesson 20.

m When you choose FILE > Print, the the Backstage
view automatically shows you a preview of the
printout. Review it carefully and adjust print settings
there before printing.

m Previewing and Printing a Worksheet

In the E10Try_xx file, click FILE > Print. @ Review the changes in the preview.
In the Settings area, in the Orientation option, 0 With your teacher’s permission, print
check that Portrait Orientation is selected. the worksheet by clicking the Print button.

Under Settings, click the Page Setup link. %Hf;ﬁfg;ﬂiﬁk the Back button @] to return to
In the Page Setup dialog box, click the Margins 9

tab.

Click the Horizontally and Vertically check boxes
under Center on page to select them, and then
click OK.

Save and close the file, and exit Excel.

v Notice that when you save a file from the Backstage
view, you exit the Backstage view.

(continued)
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m Previewing and Printing a Worksheet (continved)

Preparing and previewing before printing

E10Try_soc - Excel ? - 0O %

= Copies: |1 =
Print
Printer
‘ ., Snagit11 .
. : Read
Choose print settings here e _
1 Printer Properties
Settings e meae e e B
@ Print Active Sheets % 2 E
Only print the active sheets E E ;
= Collated 3 E i
Account EE 123 123 123 =
Options Paortrait Orientation - E_:
D Letter E
- =
85" x11" B
H Mormal Margins E
Left: 0.7 Right 0.7" =
. =
sffe  Fitshecton OnePage . 3 £
% Shrinkthe printout so that it... - = E
Page Setup i E
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Lesson 10—Practice

| Learning Microsoft Excel 2013

In this project, you will review and print formulas, change the page orientation and scaling, and preview and print a
worksheet using the skills you learned in this lesson.

DIRECTIONS

1.

Start Excel, if necessary, and open the
E10Practice file from the data files for this lesson.

Save the file as E10Practice_xx in the location
where your teacher instructs you to store the files
for this lesson.

Add a header that has your name at the left, the
date code in the center, and the page number
code at the right, and change back to Normal
view.

. Click FORMULAS > Show Formulas P& . The

formulas instead of the formula results are now
displayed on the worksheet.

Lesson 10—Apply

Click FILE > Print.

Under Settings, click Portrait Orientation >
Landscape Orientation.

Under Settings, click No Scaling > Fit Sheet on
One Page.

With your teacher’s permission, print the chart
sheet. Submit the printout or the file for grading as
required.

Save and close the file, and exit Excel.

You are the Chief Financial Officer for Hyland Manufacturing. You are finalizing the company’s balance sheet for
fiscal year 2014. You want to review and print the formulas, and preview and print the finished worksheet.

DIRECTIONS

1.

Start Excel, if necessary, and open the E10Apply
file from the data files for this lesson.

. Save the file as E10Apply_xx in the location where

your teacher instructs you to store the files for this
lesson.

Add a header that has your name at the left, the
date code in the center, and the page number code
at the right, and change back to Normal view.

4.

Display formulas instead of formula results on the
worksheet.

5. Change the print settings so that the sheet fits on

e

~

one page.
With your teacher’s permission, print the
worksheet. Submit the printout or the file for
grading as required.

Save and close the file, and exit Excel.
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End-of-Chapter Activities

Safety Consulting Services

Chapter 1

You have recently started your own business providing safety consulting services
to large businesses. You need to create a worksheet to help you track, report, and
bill work for each client at two billing rates. You will create and format the sheet,
and then enter example data to test how it works.

DIRECTIONS

1.

2.

1.

Start Excel, if necessary, and create a new, blank
file if necessary.

Save the file as ECT01_xx in the location where
your teacher instructs you to store the files for this
chapter.

. Add a header that has your name at the left, the

date code in the center, and the page number code
at the right, and change back to Normal view.

Enter the following data:

A1 Timesheet

A3 Client Name

A5 Rate A

A6 Rate B

B5 50

B6 75

D5 Weekly Retainer
F5 1750

A8 Day

B8 Date

C8 Hours Rate A
D8 Hours Rate B
E8 Amount Rate A
F8 Amount Rate B
G8 Total

D17 Total

D18 Percentage of Retainer

Enter Monday in cell A9. Fill the days Monday
through Sunday down through cell A15.

Enter 4/2/14 in cell B9. Fill the date entry down the
column through 4/8/2014 in cell B15.

Insert a column to the left of column C.

10.

11.
12.

13.

14.

15.

16.

17.
18.

19.

20.

21.
22.

23.

Enter Monday 4/2/2014 in cell C9 of the new
column C.

Enter Tuesday 4/3/2014 in cell C10.

Use Flash Fill to fill the series in the range C9:C15
with the day and date combined.

Delete column C.

Enter the formula =C9*$B$5 in cell E9. Fill the
formula down through cell E15.

Enter the formula =D9*$B$6 in cell F9. Fill the
formula down through cell F15.

In cell G9, enter a formula that adds the values in
cells E9 and F9. Fill the formula down through cell
G15.

In cell E17, enter a formula with the SUM function
that totals the values above. Fill the formula right
through cell G17.

In cell G18, enter a formula that divides the overall
total in cell G17 by the weekly retainer amount in
cell F5.

Apply the lon theme to the file.

Apply the Title cell style to cell A1, and merge and
center cells A1:G1.

Apply the 60%-Accent1 style to the label in cell
A3, then copy the formatting to the other labels in
the document (except for the dates).

Wrap and center align the range A8:G8. Adjust
column widths as necessary to display all text.

Merge the range D18:F18.

In cells B5, B6, and F5, apply the Currency format
with zero decimal places to the entries.

Apply the Currency format with two decimal
places to all the other cells calculating dollar
values.
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24. Format cell G18 as a Percentage with one 26. With your teacher’s permission, print the
decimal place. worksheet. Submit the printout or the file for
25. Enter the following sample data to test the sheet: grading as required. Your worksheet should look
like the one in lllustration 1A.
C9 225 _ _
D9 45 27. Save and close the file, and exit Excel.
ci0 2
D10 1.25

lllustration 1A A B c . D E F G
Timesheet

Client Name

Weekly Retainer

O N e LY R —

Amount  Amount
Rate A FRate B

Hours
Rate B

Hours
Rate A

Date Total

Day

Monday 4/2/2014 2.25 450 $112.50 | $337.50 $450.00
10 |Tuesday 4/3/2014 2.00 1.25/ $100.00 $93.75 $193.75
11 |Wednesday | 4/4/2014 $0.00 $0.00 $0.00
12 |Thursday 4/5/2014 $0.00 $0.00 $0.00
13 |Friday 4/6/2014 $0.00 $0.00 $0.00
14 |Saturday 4/7/2014 $0.00 $0.00 $0.00
15 |Sunday 4/8/2014 $0.00 $0.00 $0.00
14
17 $212.50 $431.25 $443.75
18 Percentage of Retainer 36.8%
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» Excel Chapter 1—Portfolio Builder

Personal Budget

You want to save for a car and need to get a better handle on your income and
expenses in order to do so. In this project, you finish a basic budget worksheet
by adding formulas and by making sure items are arranged properly. You'll apply
attractive formatting and adjust the print settings.

DIRECTIONS

1.

10.

11.
12.

Start Excel, if necessary, and open the EPBO1 file
from the data files for this chapter.
Save the file as EPB01_xx in the location where

your teacher instructs you to store the files for this
chapter.

. Add a header that has your name at the left, the

date code in the center, and the page number code
at the right, and change back to Normal view.

Insert a column to the left of column C.

Use Flash Fill to fill the range C9:C12 with the
combined text from columns A and B.

Copy the data from the range C9:C12 and paste it
to the range A9:A12.

Resize column A.

Delete columns B and C.

Enter the formula =B5+B6 in cell B7. Fill the
formula across through cell G7.

In cell B13, enter a formula that sums B9:B12. Fill
the formula across through cell G13.

Insert a blank row above the Expenses row.

Review the items in the Expenses section. You
realize that the Gifts row really belongs in the
Income area.

13.

14

15.

16.
17.
18.

19.
20.
21.

22.

23.

Insert a new row 6, drag-and-drop row 13 to row 6,
and then delete the blank row 13.

. Click cell B8, and review its formula in comparison

with the original formula you created in step 4.
Because it totals specific cells, it does not include
the Gifts data that you have moved to the Income
section. Edit the formula to correct the calculation,
and then copy or fill it across the row.

In cell B15, enter a formula that subtracts the
expense subtotal from the income subtotal. Fill the
formula across through cell G15.

Add a blank row above the Surplus row.
Apply a different theme to the workbook.

Format the labels as desired and apply the
Accounting format with zero decimal places
to the numeric data.

Hide row 2.
Display formulas.

Preview the sheet, scaling to fit the sheet on one
page with the formulas displayed.

With your teacher’s permission, print the
worksheet. Submit the printouts or the file for
grading as required.

Save and close the file, and exit Excel.





